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  COPYRIGHT  

Copyright 2013 by Chauvin Arnoux®, Inc. All rights reserved. No part of this online Help or DataView® software may be reproduced 
in any form or by any means (including electronic storage and retrieval or translation into any other language) without prior agree-
ment and written consent from Chauvin Arnoux®, Inc., as governed by United States and International copyright laws.

In USA
Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments
15 Faraday Drive • Dover, NH 03820 USA
Tel: (800) 945-2362 or (603) 749-6434 • Fax: (603) 742-2346

In Europe
Chauvin Arnoux®, Inc.
190, rue Championnet
75876 PARIS Cedex 18
FRANCE
All rights reserved.

Acknowledgements for product names used in this manual belong to the following companies: 
 � DataView® is a registered trademark of AEMC® Instruments. 
 � Microsoft Excel®, Windows® 98, 2000, ME and XP are registered trademarks of Microsoft Corp. 
 � Adobe® Reader is a registered trademark of Adobe® Systems Incorporated.

LEGAL INFORMATION  

Limited Warranty
With respect to the physical USB stick and documentation enclosed there in, Chauvin Arnoux warrants the same to be free of de-
fects in materials and workmanship for a period of 1 year from the date of purchase. In the event of notification within the warranty 
period of defects in material or workmanship, Chauvin Arnoux will replace the defective USB stick. The remedy for breach of this 
warranty shall be limited to replacement and shall not encompass any other damages, including but not limited to, loss of profit, 
special, incidental, consequential, or other similar claims.

Chauvin Arnoux specifically disclaims all other warranties, expressed or implied, including but not limited to, implied warranties of 
merchantability and fitness for a particular purpose with respect to defects in the USB stick and documentation, and the program 
license granted herein in particular, and without limiting operation of the program license with respect to any particular application, 
use or purpose. In no event, shall Chauvin Arnoux be liable for any loss of profit or any other commercial damage, including but 
not limited to, special, incidental, consequential or other damages.

What You Must Do: First request a return authorization form by phone or by fax from Chauvin Arnoux then return the USB stick 
along with the signed authorization repair form. Return material, postage pre-paid to:

In USA
Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments
15 Faraday Drive • Dover, NH 03820 USA
Tel: (800) 945-2362 or (603) 749-6434 • Fax: (603) 742-2346

In Europe
Chauvin Arnoux®, Inc.
190, rue Championnet
75876 PARIS Cedex 18
FRANCE

Disclaimer
The DataView® software and this documentation are provided “as is,” without warranty of any kind except as described in the 
Limited Warranty. By using this program (the DataView® software) you are assuming all liability for anything which might occur, 
including but not limited to physical, emotional or monetary damages.
 
Chauvin Arnoux, Inc. has made every attempt to ensure that this program operates properly. Due to the complexity of any program 
of this size, a change made in one part of the program can, and sometimes does, inadvertently generate problems in other areas. 
It is recommended that you save your work regularly (BACK UP your software).
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CONTACT INFORMATION  

Repair and Calibration
To guarantee that your Chauvin Arnoux Instrument, used with the software, complies with the factory specifications, we recommend 
that the instrument be submitted to our factory service center at one-year intervals for recalibration, or as required by other standards.
 
For instrument repair and calibration:

In USA
Call (800) 945-2362 • (603) 749-6434 • Fax: (603) 742-2346
Chauvin Arnoux®, Inc.
d.b.a. AEMC® Instruments
15 Faraday Drive
Dover, NH 03820 USA

In Europe
Call (33) 01 44 85 44 85 • Fax: (33) 01 46 27 73 89
Chauvin Arnoux®, Inc.
190, rue Championnet
75876 PARIS Cedex 18
FRANCE

(Or contact your authorized distributor.) Costs for repairs, normal recalibration, and calibration traceable to N.I.S.T. are available.
 
Note: All customers must call for an authorization number before returning any instrument.

Technical and Sales Assistance
If you are experiencing any technical problems, or require any assistance with the proper use or application of this software, please 
call our technical hotline:

In USA
Chauvin Arnoux®, Inc.
d.b.a. AEMC® Instruments
Phone: (800) 343-1391
(508) 698-2115
Fax: (508) 698-2118
www.aemc.com

In Europe
Chauvin Arnoux®, Inc.
190, rue Championnet
75876 PARIS Cedex 18
FRANCE
Phone: (33) 01 44 85 44 85
Fax: (33) 01 46 27 73 89
www.chauvin-arnoux.com
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Part 1: DataView User Interface
Menus and Options
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1. INTRODUCTION

DataView® lets you acquire and analyze data from a wide variety of Chauvin Arnoux/AEMC instruments. With DataView, you can:

 � Connect a PC to the instrument
 � Display real-time measurement data from the instrument via a frames style interface on the PC
 � Download previously recorded data from the instrument
 � Display and analyze data on the PC
 � Generate reports for viewing and printing the data, using standard templates or ones you customize to your requirements
 � Export data to a Microsoft Excel®-compatible spreadsheet

DataView also allows you to configure the instrument from the PC, though a dedicated Control Panel interface. Each family of 
instruments has its own Control Panel. Each DataView Control Panel comes with its own online Help specific to its commands 
and feature.

1.1. QUICK START DIALOG BOX
When you start DataView®, the Quick Start dialog box appears. This dialog box provides quick access to the most common op-
erations within DataView.  Note that these functions can also be performed from the menu bar; however, Quick Start allows quick 
access to these same commands.

The available options include:
 � Control Panel displays the Select Instrument dialog box. This dialog enables you to select the appropriate Control Panel 

for connecting the instrument to the PC, displaying data in real time, downloading data from the instrument, and other 
features. Note that each Control Panel has its own separate online Help system to provide information and guidance about 
that Control Panel’s specific features and capabilities.

 � Open Data File opens an existing database of recorded measurement data, so you can display this data using a user 
customized or predefined template.

 � Check for DataView Updates determines whether or not you are running the latest version of DataView software. If you 
are, a message appears informing you of this. If there is a newer version available, a dialog appears offering you the 
choice to download the software files onto your PC in either compressed ZIP or self-extracting executable (.exe) format.

 �  Open Existing Report lets you view a previously created and stored DataView data report. You can choose from the 
displayed files (the four reports you have most recently opened) or you can click More Files to display the Open dialog 
box and select additional reports.
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1.1.1. SELECT INSTRUMENT

The Select Instrument dialog box lets you select the appropriate Control Panel for your instrument.

The Select Instrument dialog consists of two fields. On the top is the Instrument field. This lists all the instrument families supported 
by DataView. Each instrument family has its own dedicated Control Panel. When you select an entry in the Instrument field, the 
Model field below it updates to display all the instrument models that are supported by the selected Control Panel. For example, 
in the illustration above PEL is selected in the Instrument field; the Model field displays the two instrument models (PEL 102 and 
PEL 103) that are supported by the PEL Control Panel.

When you open the Select Instrument, DataView attempts to identify the attached instrument.  If the connected instrument is identi-
fied, the appropriate Control Panel for that instrument will be automatically selected. If the connected instrument is not identified 
(or if no instrument is connected), the Select Instrument dialog box remains displayed so you can select the instrument family’s 
Control Panel. 

After you make your selection and click OK, the Control Panel opens. Note that each Control Panel has its own separate online 
Help system to provide information and guidance about that Control Panel’s specific features and capabilities.

1.2. DATA DISPLAY
One major function of DataView® is the analysis and display of recorded data. DataView® uses a desktop publishing approach to 
the display of information. This approach provides a View into the Data, hence the name DataView®. The view defines the type 
and placement of displayed frames on the printed page. Worksheets are displayed by DataView® using a, What You See Is What 
You Get (WYSIWYG) format.

You scroll through the displayed worksheets using the horizontal and vertical scroll bars. If the displayed worksheet can fit entirely 
within the DataView® window, the scroll bars are not displayed. If the DataView® window is too narrow (horizontally or vertically) to 
display a worksheet, then the scroll bars are displayed.

DataView® displays report worksheets. When DataView® is first run or the New report toolbar icon  is selected, a blank work-
sheet is displayed. The following figure illustrates DataView® with a blank worksheet shown in layout mode.



9

Worksheets are displayed in white with a dotted line indicating the location of the margins on the worksheet. If you prefer, the 
margins around the worksheets can be hidden by selecting the Draft display mode. This is accomplished by selecting the Draft 
option from the View menu. The following figure illustrates the display of a blank worksheet in Draft mode.

The drawing or placement area for frames is within these margins. Frames cannot be placed, moved or resized outside the margins 
of the worksheet.

1.3. TOOLBAR
The toolbar is displayed across the top of the application window, below the menu bar. The toolbar provides quick mouse access 
to many tools used in DataView®. Items on the toolbar fall into two categories: tools and buttons. A tool changes the mouse pointer 
to a corresponding DataView® tool and requires additional user action. A button performs the desired operation when the button is 
pressed (no other action is required).
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To hide or display the Toolbar, choose Toolbar from the View menu (Alt, V, T).

Click Name Description

 New Creates and opens a new report.

 Open Opens an existing report. DataView® displays the Open dialog box, in which you can locate
  and open the desired file.

 Save Saves the active report or template with its current name. If you have not named the report,
  DataView® displays the Save As dialog box.

 Home Displays the Quickstart dialog box.

 Print Prints the active report.

 Print Preview Displays the active report, as it will look printed.

 Cut Removes the selected frame from the report and stores it on the clipboard.

 Copy Copies the selected frame to the clipboard.

 Paste Inserts the contents of the clipboard into the active report.

 Select Frame Changes the mouse pointer to the select tool.

 Watch Value Enables the display of the Value at Cursor function.

 Edit Session Opens the Session Properties dialog box for the database used in the active report.
 Properties

 Link Frame Creates a new frame linked to the currently selected frame. The available types of frames will
  depend of the type of frame selected prior to issuing this command.

 Create Frame Changes the mouse pointer to the Create Frame tool.

 Place Graph Changes the mouse pointer to the Create Frame Graph tool.

 Place TOC Changes the mouse pointer to the Table of Contents Frame tool.

 Place Text Changes the mouse pointer to the Text Frame tool.

 Place OLE Changes the mouse pointer to the OLE Frame tool.

 Place Word OLE Changes the mouse pointer to the OLE Frame tool allowing the insertions of a Word document.

 Draw Arrow Changes the mouse pointer to the Arrow tool.

 Draw Line Changes the mouse pointer to the Line tool.
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 Draw Box Changes the mouse pointer to the Box tool.

 Zoom Selection Changes the mouse pointer to the zoom selection tool.

 Zoom Previous Resets the display duration and starting display offset of the selected graphical frame to the
  previous zoom extents.

 Zoom In Increases the zoom magnification of the selected graphical frame.

 Zoom Out Decreases the zoom magnification of the selected graphical frame.

 Zoom All Resets the zoom magnification to display all of the channel measurements in the graph.

 Pan To Start Sets the display start time for the selected graphical frame to the start of the saved data. The
  display duration (zoom magnification) remains the same.

 Pan Left Sets the displayed start time for the selected graphical frame to a time 90% less than the
  current time. Subtracting a percentage of the display duration from the start time does this.
  The display duration remains the same.

 Step Left Sets the displayed start time for the selected graphical frame to a time 10% less than the
  current time. Subtracting a percentage of the display duration from the start time does this.
  The display duration remains the same.

 Step Right Sets the displayed start time for the selected graphical frame to a time 10% greater than the
  current time. Adding a percentage of the display duration to the start time does this. The display
  duration remains the same.

 Pan Right Sets the displayed start time for the selected graphical frame to a time 90% greater than the
  current time. Adding a percentage of the display duration to the start time does this. The display
  duration remains the same. 

 Pan To End Sets the display start time for the selected graphical frame to the time of the last data point
  minus the display duration. The display duration remains the same.

 Bring To Front Moves the selected frame to the beginning of the view’s frame list.

 Send To Back Moves the selected frame to the end of the view’s frame list.

1.4. STATUS BAR
The Status bar is located at the very bottom of the DataView® window. To display or hide the status bar, use the Status Bar com-
mand in the View menu.

The status bar indicates information about various menu options and the program’s operational state. On the left side of the status 
bar is a one line prompt about highlighted menu options. If no menu option is highlighted, it informs you that pressing the F1 func-
tion key will display the on-line help. On the right side of the status bar are four panes. The first indicates the current worksheet 
and number of worksheets in the report. The last three panes indicate the state of the Caps lock, Num lock and Scroll lock keys.
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1.5. TITLE BAR
The Title Bar is located along the top of the DataView® application window and contains the name of the application and active report.

To move the window, drag the title bar. A title bar may contain the following elements:

 � Application Control-menu button
 � Report Control-menu button
 � Name of the application
 � Name of the active report
 � Minimize button
 � Maximize button
 � Restore button
 � Close (Exit) application button

1.6. SCROLL BARS
Displayed at the right and bottom edges of the report window, the scroll boxes inside the scroll bars indicate your vertical and 
horizontal location in the report. You can use the mouse to scroll through the displayed worksheets using the horizontal and verti-
cal scroll bars.

If the displayed worksheet can fit entirely within the DataView® window, the scroll bars are not displayed. If the DataView® window 
is too narrow (horizontally or vertically) to display a worksheet, then the scroll bars are displayed.

1.7. MIDIFYING THE VIEW
Another major function of DataView® is the analysis and display of recorded data. DataView® uses a desktop publishing approach 
to the display of information. This approach provides a View into the Data, hence the name DataView®. The view defines the type 
and placement of displayed frames on the printed page. Worksheets are displayed by DataView® using, What You See Is What 
You Get (WYSIWYG) format.

DataView® displays report worksheets. When DataView® is first run or the New report toolbar icon  is selected, a blank work-
sheet is displayed. Worksheets are displayed in white with a gray border around them. If you prefer, the gray borders around the 
worksheets can be turned off by selecting the Draft display mode. This is accomplished by selecting the Draft option from the View 
menu.

In either case, a dotted line is drawn on each worksheet indicating the location of margins. The drawing or placement area for 
frames is within these margins. Frames cannot be placed, moved or resized outside the margins of the worksheet.

2. FILE MENU

The File menu offers the following commands:

 � Quick Start opens the DataView® Quick Start dialog box (see Section 1.1).
 � New creates a new report.
 � New From Template opens the Create Report from Template dialog box.
 � Open displays a sub menu allowing you to select one of the three file types supported by DataView® (Database, Report and 

Template).
 � Close closes an opened report.
 � Save saves an opened report using the same file name.
 � Save As saves an opened report to a specified file name.
 � Save As Template saves the current report as a Template.
 � Archive copies the current report and all of the attached database files to a user specified location.
 � Database displays the Database Properties dialog box.
 � Export to Spreadsheet displays the Database Properties dialog box (performs the same operation as the Database command. 

It is repeated with another name to make it easier to find what you may want).
 � Page Setup displays the Page Setup dialog box.
 � Print Worksheet prints a worksheet.
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 � Print All Worksheets prints all the worksheets of the current document.
 � Print Preview displays the report on the screen, as it would appear printed.
 � Generate PDF generates a static PDF formatted file for electronic distribution.
 � Generate Metafile generates a static Metafile formatted file for electronic distribution.
 � Send... sends the active report through electronic mail.
 � Exit exits DataView®.

2.1. NEW
The New command on the File menu opens a window for creating a new custom DataView® report from the data contained in a 
selected recording session downloaded from the instrument. (By default, this is the most recently opened downloaded database.) 
Reports consist of one or more frames. These are rectangular boxes in which graphical items such as lines, text and graphs are 
displayed. All items displayed by DataView are contained in frames.

To create a custom report, you can:
 � Select and place frames in the report window, using a set of command icons.
 � Create a “generic” frame from scratch.
 � Modify a frame after you have created it.
 � Copy and move frames to the desired location within the report.

After you finish the report you can save it both as a report and as a template from which you can create other DataView reports. 
To create a report from an existing template, select the New from Template command from the File menu.

2.2. NEW FROM TEMPLATE
The New from Template command lets you create a DataView report from an previously existing report template. When you select 
this command, the Create Report from Template dialog box appears:

 � Select Instrument displays a list of instruments supported by DataView. This selection determines which templates ap-
pear in the adjacent Select Template field.

 � Select Template lists the templates available for the instrument selected in the Select Instrument drop-down list (see above).

 � Browse opens the Open dialog box, from which you can browse your computer’s folders to search for templates not listed 
in the Select Template list.

 � Specify Database(s) determines which database(s) or recorded data will be associated with this report template. If a 
database you want to select is not displayed in the list, you can search for additional databases by clicking the Browse 
button. If the database(s) have already been specified (either prior to invoking this dialog box or by selecting the Browse 
button) and none of these database entries is selected, the Browse button is disabled.
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As the Create Report from Template dialog box indicates, this is a two-step process: (1) Specify the template, then (2) Specify the 
database. If you have previously downloaded data into DataView from an instrument, the Specify Database list will display the 
name of the previously specified database. 

When a template is selected, it is scanned to identify the number of databases it requires. The number of databases is indicated in 
the Specify Database list box. For example, selecting a template that calls for two different databases, results with “1:” and “2:” 
entries appearing in the database list box.

 
2.3. OPEN
The Open command on the File menu displays a sub-menu consisting of three options:

 � Open database opens a database containing data from a previously recorded session that has been downloaded from 
the instrument to the PC.

 � Open report opens an existing DataView report.
 � Open template opens a DataView report template.

When you open a database, report, or template; the Close command appears in the File menu. Use the Close command to close 
the session.

2.3.1. OPEN DATABASE

The Open Database command on the Open menu opens a database containing data from a previously recorded session that 
has been downloaded from the instrument to the PC. This is a two-step process: (1) Specifying which database to open, and (2) 
Selecting the report template through which to view this data. When you select Open, the Open dialog box appears:

You can enter the name of the database file in the File name field, or browse your folders for available DataView database (.dvb) 
files. For example, to search for databases containing recorded measurement data downloaded from PEL 100 instruments, ensure 
that the DataView Database Files (*.dvb) button is displayed, and then click the PEL folder. A list of available PEL data files will 
be displayed.

After you select the database and click OK, the Create Report from Template dialog box appears. Select the template through 
which to view the specified database, and click OK. The data contained in the database, formatted in accordance with the selected 
template, appears on the screen.  

When you are finished viewing the data, you can save it to a file by using the Save or Save as commands. You can also save the 
report as a DataView template.

2.3.2. OPEN REPORT

The Open Database command on the Open menu opens an existing DataView report. When you select this option, the Open 
dialog box appears. You can enter the name of the report file in the File name field, or browse your folders for available DataView 
report (.dvb)  files. For example, to search for Simple Logger II reports, ensure that the DataView Report Files (*.dvw) button is 
displayed, and then click the Simple Logger II folder. A list of available Simple Logger II reports will be displayed.

After you select the report and click Open, the report is displayed on the screen.  When you are finished viewing the report, you 
can save it by using the Save or Save as commands. You can also save the report as a DataView template.
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2.3.3. OPEN TEMPLATE

The Open Template command on the Open menu opens an existing DataView report template. A template is a file that defines 
the type, placement and properties of frames in a report.

When you select this option, the Open dialog box appears. You can enter the name of the template file in the File name field, or 
browse your folders for available DataView template (.dvt) files. For example, to search for Ground Tester templates, ensure that 
the DataView Template Files (*.dvt) button is displayed, and then click the GTC folder. A list of available Ground Tester report 
templates will be displayed.

After you select the report and click Open, the report is displayed on the screen.  When you are finished viewing the report, you 
can save it by using the Save or Save as commands. You can also save the report as a DataView template.

2.4. CLOSE
The Close command appears on the File menu when a DataView database, report, or template is open. (At other times, this com-
mand is not displayed.) If the report you are viewing is untitled -- for example, you have created a new report, or have opened a 
database and are viewing it through a selected template -- you will be asked whether or not you want to save the report. If you 
click Yes, the Save As dialog box appears. You will similarly be asked whether or not you want to save your changes if you modify 
an existing report or template.

Note that you can also close a report by: 

 � Clicking the DataView icon that appears on the far left of the Menu bar:

 

 This displays a menu on which Close is an option.

 � Pressing Ctrl-F4

Both actions initiate the Close procedure describe above.

2.5. SAVE
The Save command on the File menu saves any modifications you have made to a new or existing DataView report or template.

 � If the report or template has been previously saved (for example, you are viewing a database using a selected template), 
the Save command saves the updates to the existing file name. 

 � If the report or template has not been previously saved, the Save As dialog box appears.

In both cases, you will be returned to your report editing session after the Save operation is complete.

You can also save modifications to a report or template by:

 � Clicking the Save icon on the Command toolbar:

 

 � Pressing Ctrl S

Both actions function similarly to the Save command.
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2.6. SAVE AS 
Save As performs two primary functions: (1) saving a new file, and (2) saving a previously saved file under a different filename. 
The Save As dialog box appears as follows:

The appearance of the Save As dialog box may differ slightly, depending on where it has been invoked. For example, the preceding 
illustration shows the Save As dialog box as it appears when opened via the Save As command on the File menu, after the user 
has selected Open Database from the Open menu and created a new DataView report. 

The File name field on the dialog box lets you enter a name for the file. This can be a new name, or the name of an existing file you 
plan to overwrite. In some instances (depending when Save As was invoked), the Save as type drop-down lets you select from 
multiple formats under which to save the file. In other situations, such as the example shown above, only one file type is allowed.

By default, the Save As dialog displays your folders, which you can browse to select the name of an existing file or to choose a 
location in which to save the new file. The Hide/Browse Folders button at the bottom left of the dialog box lets you toggle between 
displaying the folders and hiding them.

2.7. SAVE AS TEMPLATE
The Save as Template command on the File menu saves the open report as a DataView template. When you select this command, 
the Save As dialog box appears. When saving the template, the Save as type field offers two choices:

 � DataView Template Files (*.dvt) saves the template and associates it with one or more DataView databases (.dvb files). 
These databases will provide the data displayed in the frames whenever the template is subsequently opened.

 � DataView Template Files w/o database (*.dvt) saves the template without associating it with any DataView database. 
When the template is subsequently opened, its frames will not contain any data.

Note that the Save as Template command only appears on the File menu when a report is open.

2.8. ARCHIVE
The Archive command makes copies of the currently open report and all attached database files, and places them in a user 
specified location.  This is convenient when the database files for a report are not located in the same directory as the report file.  
Archive lets you copy all the files to a given directory.  You can then compress them and send the files to another user.
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When you select Archive from the File menu, the Choose Directory dialog box appears:

Select the drive and directoy to which you want the files copied, and lock OK. The files will be copied to the specified location.

2.9. DATABASE
The Database command displays the Database dialog box.  The Database dialog box allows you to edit the session information 
of a database and export measurement values stored in a database.  The Database dialog box displays a list of database files 
that have been loaded.  When first displayed, this list contains the names of all the databases currently loaded by all of the report 
currently open in DataView®.  Additional databases can be added to the list using the Load another database button.

Below this are a set of buttons:

 � Export measurements begins the export operation for measurements contained within the currently selected database.  
When this option is selected, the Export Step 1 dialog box is displayed.

 � Load another database allows you to add another database file to the list of databases.  Use this button to add a database 
which you want to modify or export to the Loaded Databases list.

 � Edit session information opens the Session Properties dialog box. This enables you to enter information about the site 
where the test took place and the person who conducted the test.

 � Trim database lets you create a new database consisting of a subset of the information contained in the selected database. 
When you select this option you are prompted to enter a name for the new “trimmed” database, as well as start and end 
dates/times that define the recording period you want to include in this database.

 � Combine databases opens a dialog box for merging two or more selected databases into a new single database.

2.9.1. EDIT SESSION INFORMATION

At the time a database is created, you are given the opportunity to specify various operator, site and comment information.  This 
information is called the Session Properties.  The Session Properties can be changed at a later date using the Database Inspector 
dialog box.  To edit the Session Properties, perform the following steps:
 

1. Select Database from the File menu. The Database dialog box will be displayed. 
2. If the desired database is not listed then load it using the Load another database button. 
3. Select the database to be edited from the list of loaded databases. 
4. Select the Edit session information button. The Session Properties dialog box will be displayed. 
5. Edit the session fields as needed. 
6. Select the Save button to save the changes into the database.

If the database contains more than one session, you can select the next session by selecting the Next Session >> button.  The 
<< Previous Session button displays the session that comes before the current session properties. The Next Session >> button 
will be disabled when only one session is present or when you are viewing the last session in a multiple session database.  The 
Previous Session >> button will be disabled when only one session is present or when you are viewing the first session in a 
multiple session database.
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2.9.1.1 Session Properties dialog box
The Session Properties dialog box allows you to attach textual information to the recorded data.

This dialog box allows you to specify information about the recorded session. This information falls into three categories:

 � Operator information - information about the person performing the test.
 � Site information - information about the place and facility the test was performed at.
 � Comments - any additional information you wish to keep with the recorded data.

 
This information is saved along with the recorded data. Selecting the Make Default button will save the current field values (except 
comments) making them the default for subsequent Session Properties dialog boxes. Selecting the OK button will accept the ses-
sion information and save it and the recorded data to the database file previously specified.

2.10. EXPORT MEASUREMENT
Measurement values stored in a DataView® database can be exported to a comma separated file using the Export operation.  To 
export measurement values from a database, perform the following steps: 

1. Select either Database or Export to a Spreadsheet from the File menu.  The Database dialog box will be displayed. 
2. If the desired database is not listed then load it using the Load another database button. 
3. Select the database whose session information is to be edited. 
4. Select the Export measurements button. The Export Step 1 – Specify Export File Name dialog box will be displayed. 
5. Specify the name of the export file in the edit box (Export File field). 
6. Select the Next >> button. The Export Step 2 – Select Channel dialog box will be displayed. 
7. Select the channel from which the measurement values are to be exported. 
8. Select the Next >> button. The Export Step 3 – Select Parameters dialog box will be displayed. 
9. Select the desired measurement parameters by adding them to the Selected list. 
10. Select the Finish >> button. 

At this point the selected parameters, from the selected database will be exported to the specified file.

2.10.1. EXPORT STEP1 -SPECIFY EXPORT FILE NAME DIALOG BOX

The Export Step 1 – Specify Export File Name dialog box is the first step in the export operation.  It allows you to specify the 
name of the file to export the measurement values to.  When first displayed, the export file name defaults to the name of the da-
tabase with .csv given as the file extension.
 
The name of the database previously selected, from which the measurement values will be extracted, is displayed above the 
Export File name.  This cannot be changed and is shown for information only.  To change the database selected, cancel the export 
process and select a different database in the Database dialog box.
 
To continue to the next step in the export operation, select the Next >> button.
 
To cancel the export operation, select the Cancel button.
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2.10.2. EXPORT STEP 2 - SELECT CHANNEL DIALOG BOX

The Export Step 2 – Select Channel dialog box displays a list of measurement channels contained within the associated database 
and allows you to select one of these channels to be exported.
 
In addition, the name of the database containing the measurement data is displayed.  The name of the export file specified in the 
previous step is also displayed.
 
To continue to the next step in the export operation, select the Next >> button.
 
To cancel the export operation, select the Cancel button.
 
To go back to the previous step, select the << Previous button.

2.10.3. EXPORT STEP 3 - SELECT PARAMETERS DIALOG BOX

The Export Step 3 – Select Parameters dialog box allows you to specify the parameters and order of the parameters to be exported.
 
To select a given parameter to export, select it from the Available list and click on the Add>> button.  The parameter will be added 
at the bottom of the Select list.
 
Selecting the Add All>> button will add all of the parameters to the export list.
 
Selecting the <<Remove All button will remove all (clear) the parameters in the Select list.
 
To remove a given parameter from the Selected list, select it and click on the <<Remove button.
 
The order in which parameters are exported can be changed by selecting each Selected parameter and moving it up and down in 
the list using the Promote and Demote button.  An item higher in the list is exported before an item lower in the list.
 
The parameters selected for export and the order of these parameters can be saved as the default by selecting the Make Default 
button.  The next time a channel of this same type is selected for export, the Selected list will default to the parameters selected 
when the Make Default button was selected.
 
To complete the export operation, select the Finish >> button.
 
To cancel the export operation, select the Cancel button.
 
To go back to the previous step, select the << Previous button.

2.11. PAGE SETUP
Use this command to display the Page Setup dialog box. This dialog box allows you to change the layout of the page used in 
displaying and printing the report.

2.12. PRINT WORKSHEET
Use this command to print the currently selected worksheet in the active report. This command presents a Print ialog box, where 
you may specify the number of copies, the destination printer, and other printer setup options.

Shortcuts

Toolbar: 
Keys: Ctrl+P

2.13. PRINT ALL WORKSHEETS
Use this command to print all the worksheets in the active report. This command presents a Print dialog box, where you may specify 
the number of copies, the destination printer, and other printer setup options.
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2.14. PRINT PREVIEW COMMAND
Use this command to display the active report as it would appear when printed. When you choose this command, the main window 
will be replaced with a print preview window, in which one or two pages will be displayed in their printed format. The Print Preview 
Toolbar offers you options to view either one or two pages at a time; move back and forth through the report; zoom in and out of 
pages; or, initiate a print job.
 
Shortcuts

Toolbar:

2.15. GENERATE PDF
Use this command to generate a static version of the currently loaded report. This static report file can be viewed by the Adobe 
Reader®. You can then send this file to someone that does not have DataView® installed on his or her computer. The Adobe Reader 
program is a small and freely distributable program that allows for electronic distribution of reports.
 

1. When this command is selected, a Print dialog box will be displayed allowing you to limit the pages of the report and
 customize the output (via the Properties... button).
2. Generate the PDF file by selecting the OK button.
3. Once the PDF has been generated you will be asked to specify a name and location to save the PDF file.
4. Once the name and location has been specified select the OK button.

If you have a PDF reader installed the PDF file will be opened for your viewing.

2.16. GENERATE METAFILE
Use this command to generate a static version of the currently loaded report.  This static report file can be viewed by the DataView® 
MetaViewer.  You can then send this file to someone that does not have DataView® installed on his or her computer.  The DataView® 

MetaViewer program is a small and freely distributable program that allows for electronic distribution of reports.
 
When this command is selected, a Save As dialog box will be displayed allowing you to specify the name and location of the 
DataView® Metafile file.  The metafile can be saved in two formats selectable from the Save as type: drop-down list.
 
The first and default type (DataView® Meta Files (*.dmf)) is an enhanced version of the Windows metafile.  It contains all worksheets 
of the report in a single file.  For this reason you cannot load this file directly into other programs.  However, this does allow the 
report to be viewed as a whole using the DataView® MetaViewer.
 
Alternately, you can select the Windows Metafile format from the Save as type: drop-down list.  When saving in this format a 
metafile for each worksheet in the report will be generate.  The name of each worksheet file uses the file name you specified plus 
an index for the corresponding worksheet number.  For example, if you specify a file name of Power Quality for a three-worksheet 
report, the following files will be created (in the specified directory):
 

Power Quality-001.emf
Power Quality-002.emf
Power Quality-003.emf

 
Each of these files can be loaded directly into a program that supports Windows enhanced metafiles.

2.17. SEND
Use this command to send the active report through electronic mail.  This command presents an e-mail window with the active 
report attached to it.  You may then fill out the To: field, Subject: field, etc., and add text to the body of the message if you wish.  
When you are finished you may click the Send button to send the message.

2.18. FILE 1, 2, 3, 4
Use the numbers and filenames listed at the bottom of the File menu to open the last four views you closed.  Choose the number 
that corresponds with the report you want to open.

2.19. EXIT
Use this command to end your DataView® session.  You can also use the Close command on the application Control menu.  
DataView® prompts you to save views with unsaved changes.
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3. EDIT MENU

The Edit menu offers the following commands:

 � Undo reverses previous editing operation.
 � Redo reverses the effect of the last undo command.
 � Cut deletes data from the report and moves it to the clipboard.
 � Copy copies data from the report to the clipboard.
 � Paste pastes data from the application clipboard into the report.
 � Paste Special pastes data from the Windows clipboard into the report.
 � Add Worksheet adds a worksheet to the active report.
 � Delete Worksheet deletes a worksheet from the active report.
 � Rename Worksheet changes the text displayed on the worksheet tab and footer of printed worksheet pages.
 � Duplicate Worksheet duplicates the currently selected worksheet (including all frames on that worksheet).
 � Move Worksheet changes the order of the Worksheet tabs.
 � Edit Session Properties opens the Session Properties dialog for the database used in the active report.
 � Insert New Object inserts and embeds an object, such as a chart or an equation in a report.
 � Links lists and edits links to embedded objects.

3.1. UNDO
Use this command to reverse the last editing action, if possible. The undo command is grayed on the menu if the undo command list 
is empty. The undo command list allows you to undo the last 10 undoable commands. If a non-undoable command is performed, it 
is not added to the list and the list is not modified. For this reason, the undo command list reflects the last 10 undoable commands 
even if non-undoable commands were given.
 
The following is a list of commands that can be undone:

 � Move frame
 � Resize frame
 � Place frame
 � Delete frame
 � Change frame properties
 � Delete worksheet (provided the undo buffer can hold copies of all frames on the worksheet being deleted). 

 
Each command that is undone is added to the list of redo commands. Commands such as zooming and panning are not added 
to the undo list and therefore cannot be undone with this command, although you can use the zoom previous command to undo 
a zoom or pan operation.
 
The Delete Worksheet command will empty the undo command list prior to deleting the worksheet. Each frame deleted from the 
worksheet is then added to the undo command list. When the undo command is given for the delete worksheet command, the 
worksheet and all frames that were on it are restored. However, if there are more frames on the worksheet being deleted than 
can fit in the undo list, the worksheet deletion command cannot be undone. In which case, the undo command is left empty. If the 
worksheet deletion command cannot be added to the undo command list, you will be warned prior to the worksheet being deleted, 
at which time you can make the final decision if deletion of the worksheet should continue.

3.2. REDO
Use this command to reverse the last Undo action, if possible. The Redo command is grayed on the menu if you cannot reverse 
your last Undo action.
 
Each command undone is added to the list of redo commands. When the report is modified such that the new action is added to 
the undo command list, the redo command list is cleared. For this reason, the redo command is available only after an undo com-
mand is given and before any other command is given.

3.3. CUT
Use this command to remove the currently selected frame from the report and put it on the clipboard. This command is unavailable 
if a frame is not currently selected.
 
Cutting a frame to the clipboard replaces the contents previously stored there.
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3.4. COPY
Use this command to copy the selected frame onto the clipboard. This command is unavailable if a frame is not currently selected.
 
Copying a frame to the clipboard replaces the contents previously stored there.

3.5. PASTE
Use this command to insert a copy of the clipboard contents into the active report. Once inserted it can be moved and resized as 
needed. This command is unavailable if the clipboard is empty.
 
Shortcuts

Toolbar: 
Keys: Ctrl+V

3.6. PASTE SPECIAL
Use this command to insert a copy of the Windows clipboard contents into the active report. This command is unavailable if the 
Windows clipboard is empty.

3.7. ADD WORKSHEET
This command displays the Insert Worksheet dialog box, which allows you to add a worksheet to the report. To add a worksheet 
to the currently active view, perform the following steps: 

1. Select the Add Worksheet command from the Edit menu. The Insert Worksheet dialog box will be displayed. This dialog
 box allows you to insert a worksheet before or after a specified worksheet. The worksheet number defaults to the currently
 displayed worksheet. The number of the current worksheet is given on the status bar and reflects the last worksheet the
 mouse pointer was over before selecting the Add Worksheet command.

2. Change the worksheet number, if needed, and specify if the new worksheet is to go before or after the specified worksheet.
 For example, to insert a worksheet before the first worksheet in the report, set the worksheet number to 1 and select
 Before specified worksheet.

3. Once the worksheet number and insertion mode are specified, click the OK button. The new worksheet will be inserted
 into the report at the specified location. All worksheets in the report will be renumbered as needed and the frames on
 those worksheets will be moved along with them.

3.8. DELETE WORKSHEET
In addition to adding worksheets to a report, they can also be deleted. When deleting a worksheet from a report, all the frames 
contained on that worksheet will be deleted as well. Unlike the Cut command, frames deleted in this manner will not be copied to 
the application and Windows clipboards. For this reason, be very careful not to delete the wrong worksheet. To remove a worksheet 
from the currently active report, perform the following steps:

1. Select the Delete Worksheet command from the Edit menu. The Delete Worksheet dialog box will be displayed. This
 dialog box allows you to specify which worksheet is to be deleted. The worksheet number defaults to the currently
 displayed worksheet. The number of the current worksheet is given on the status bar, and reflects the last worksheet the
 mouse pointer was over before selecting the Delete Worksheet command.

2. Change the worksheet number, if needed, to the number of the worksheet you want deleted.

3. Once the worksheet number is specified, click the OK button. If any frames are currently on the specified worksheet, a
 dialog box asking for confirmation to delete the worksheet will be displayed. This dialog box is displayed only when the
 worksheet to be deleted contains frames. Continuing with the deletion of the specified worksheet will also delete all the
 frames contained on that worksheet. If you still want to delete the worksheet, then click on the Yes button. Otherwise, click
 on the No button and the delete worksheet process will be canceled. If the specified worksheet does not contain any
 frames, then this dialog box is not displayed and the worksheet is simply deleted.

 

3.9. RENAME WORKSHEET
Allows you to edit and change the text displayed on the worksheet tab and footer of printed worksheet pages.
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3.10. DUPLICATE WORKSHEET
The Duplicate Worksheet command inserts a new worksheet into the report and copies the frames on the current worksheet to 
the newly inserted worksheet. If a parent and child frame (that are linked) are copied, the new child frame is linked to the new 
parent frame.

3.11. MOVE WORKSHEET
The Move Worksheet command changes the order of tabs on the Worksheet Tab bar.  When this command is selected the Move 
Worksheet dialog is displayed. This dialog allows you to specify the new location of the currently selected worksheet.

3.12. EDIT SESSION PROPERTIES
The Edit Session Properties command allows you to change the session properties of the database used in the active report.  When 
this command is selected the Session Properties dialog is displayed. This dialog allows you to specify the session properties for 
the database used in the active report. (See also Section 2.10.1.)

4. VIEW MENU

The View menu offers the following commands:

 � Draft shows the active report in draft mode. 
 � Layout shows the active report in layout mode. 
 � Links  displays the child/parent links between frames. 
 � Watch enables/disables the value at cursor display. 
 � Grid enables/disables the display and snap to grid for frames. 
 � Toolbar shows or hides the toolbar. 
 � Status Bar shows or hides the status bar. 

 
4.1. DRAFT
Displays worksheets in draft mode.

4.2. LAYOUT
Displays worksheets in layout mode.

4.3. LINKS
Enables/disables the display of frame identification (FID) numbers and parent identification (PID) numbers for each frame. This 
allows you to identify associations between frames.

4.4. WATCH
Use this command to enable/disable the display of the value at cursor for graph frames. The watch value can float (follow) the 
mouse pointer or can be locked in place. The Lock Watch and Unlock Watch options in the pop-up menu fix and release the watch 
text. To fix the watch text, position the mouse pointer at the desired location, then click and release the right mouse button. The 
pop-up menu will be displayed. Select the Lock Watch menu option. To release the watch text, perform the same steps except 
select the Unlock Watch menu option.
 
The value displayed in the watch window can be pasted onto the graph at its current location. To paste the text value onto the 
graph, right-click the mouse at the desired location and select Paste Watch from the pop-up window.
 
In the normal mode of operation the watch text window follows the cursor around the screen. You can fix the location of the watch 
window by right-clicking the mouse at the desired location and selecting Lock Watch from the pop-up window. To release the 
watch window, right-click the mouse and select Unlock Watch from the pop-up window.
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4.4.1. PASTE WATCH

When the watch value box is enabled, you have the option of pasting the value onto the report as a text box by right-clicking the 
mouse and selecting Paste Watch from the pop-up menu.

4.5. GRID
Use this command to turn on and off the layout grid. When enabled, the menu option has a check next to it and a grid of points is 
displayed on the worksheet. The grid forces frame placement to the nearest grid locations.

4.6. TOOLBAR
This menu option contains a submenu containing following options:

 � Basic: use this command to switch to the basic toolbar. The basic toolbar is limited to review buttons only.
 � Advanced: use this command to switch to the advanced toolbar. The advanced toolbar contains controls for review and 

modification.
 � Hide: use this command to hide the Toolbar. This menu option is grayed when the toolbar is hidden.
 � Show: use this command to display the Toolbar. This menu option is grayed when the toolbar is displayed.

4.7. STATUS BAR
Use this command to display and hide the Status Bar. A check mark appears next to the menu item when the Status Bar is displayed.
 
See Section 1.4 for information about using the status bar.

5. FRAME MENU

 � Select Frame enables the Select Frame tool, changing the mouse pointer to the Frame Selection tool.
 � Link Frame enables the Link Frame tool, for creating a new frame linked to the currently selected frame.
 � Change Link allows you to assign another frame as the parent of a child frame.
 � Frame Properties displays the properties dialog box associated with the currently selected frame.
 � Frame Background displays the color dialog box allowing you to specify the background color for the currently selected 

frame.
 � Send To Back moves the selected frame to the end of the views frame list.
 � Bring To Front  moves the selected frame to the beginning of the views frame list.
 � Lock Frame locks down the frame at its current position and size in the report.
 � Unlock Frame releases a previous lock placed on a frames placement in the report.
 � Lock All Frames locks down all the frames in the active report at their current position and size in the report.
 � Unlock All Frames unlocks all frames in the active report.
 � New Frame enables the Create Frame tool, changing the mouse pointer to the Generic frame tool.
 � Place Graph enables the Place Graph tool, changing the mouse pointer to the Graph frame tool.
 � Place TOC enables the Place TOC tool, changing the mouse pointer to the TOC frame tool.
 � Place Text enables the Place Text tool, changing the mouse pointer to the Text frame tool.
 � Place OLE enables the Place OLE tool, changing the mouse pointer to the OLE frame tool.
 � Place Word OLE enables the Place Word OLE tool, changing the mouse pointer to the Word OLE frame tool.
 � Draw Arrow enables the Draw Arrow tool, changing the mouse pointer to the Arrow tool.
 � Draw Line enables the Draw Line tool, changing the mouse pointer to the Line tool.
 � Draw Box enables the Draw Box tool, changing the mouse pointer to the Box tool.

5.1. SELECT FRAME
Changes the mouse pointer to the Frame Selection tool, allowing a frame to be selected by clicking on it. 
 
Shortcuts

Toolbar:  
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5.2. LINK FRAME
Creates a new frame linked to the currently selected frame. The available types of frames will depend on the type of frame selected 
prior to issuing this command. 
 
Shortcuts

Toolbar:    

5.3. CHANGE LINK
Assigns another frame as the parent of the currently selected child frame. To use this command you first select the child frame.  
Next, select the Change Link command from the Frame menu. The mouse pointer will change to the Change Link tool. Then, 
select the frame that is to become the new parent for the selected frame. The new parent must be of the same type as the current 
parent frame.

5.4. PROPERTIES
Opens the Properties dialog box associated with the selected frame. Each frame type has a unique properties dialog box.

5.5. FRAME BACKGROUND
Displays the color dialog box allowing you to specify the background color for the currently selected frame.

5.6. SEND TO BACK
Moves the selected frame to the end of the views frame list. This option allows you to change the frame selection order. For exam-
ple, if two frames are placed on top of each other in a report, the top frame will always get selected when using the frame selection 
tool. Using this command changes the frame selection order and allows the other frame to be selected.
 
Shortcuts

Toolbar:    

5.7. BRING TO FRONT
Moves the selected frame to the beginning of the views frame list. This option allows you to change the frame selection order.
 
Shortcuts

Toolbar:    

5.8. LOCK FRAME
Locks the selected frame at its current location and size. The frame will remain locked until it is unlocked via the Unlock Frame 
command. While a frame is locked, you will not be able to move it or change its size.
 
Frame locking is useful when you don’t want to accidentally move or change the size of the frame. Selecting a frame via the selec-
tion tool can result in it inadvertently being moved if it is not locked in place.
 
This command is only available when a frame is selected and the selected frame is unlocked. Once the selected frame is locked, 
the Lock Frame command will be grayed and the Unlock Frame command will be enabled. Also, while a frame is locked, the cursor 
does not change to the frame resize or move cursor icons.

5.9. UNLOCK FRAME
Unlocks the selected frame and allows it to be moved and resized. The frame will remain unlocked until it is locked via the Lock 
Frame command. While a frame is unlocked you will be able to move it and change its size.
 
Frame locking is useful when you don’t want to accidentally move or change the size of the frame. Selecting a frame via the selec-
tion tool can result in it inadvertently being moved if it is not locked in place.
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This command is only available when a frame is selected and the selected frame is locked in place. Once the selected frame is 
unlocked, the Unlock Frame command will be grayed and the Lock Frame command will be enabled.

5.10. LOCK ALL FRAMES
Locks all of the frames in the active report at their current location and size. The frames will remain locked until they are unlocked 
via the Unlock Frame command. While a frame is locked, you will not be able to move it or change its size.

5.11. UNLOCK ALL FRAMES
Unlocks all the frames in the active report and allows them to be moved and resized. The frames will remain unlocked until they 
are locked via the Lock Frame command. While a frame is unlocked you will be able to move it and change its size.

5.12. NEW FRAME
Changes the mouse pointer to the generic frame tool, allowing a frame to be created and placed in the report. 
 
Shortcuts

Toolbar:    

5.13. PLACE GRAPH
Changes the mouse pointer to the Create Graph frame tool, allowing a graph frame to be created and placed in the report. 
 
Shortcuts

Toolbar:    

5.14. PLACE TOC
Changes the mouse pointer to the Table of contents frame tool, allowing a Table of Contents frame to be created and placed in 
the report. 
 
Shortcuts

Toolbar:    

5.15. PLACE TEXT
Changes the mouse pointer to the Text frame tool, allowing a text box frame to be created and placed in the report. 
 
Shortcuts

Toolbar:    

5.16. PLACE OLE
Changes the mouse pointer to the OLE frame tool, allowing an OLE item to be created and placed in the report. 
 
Shortcuts

Toolbar:   
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5.17. PLACE WORD OLE 
Changes the mouse pointer to the Word OLE frame tool, allowing a Word documents frame to be created and placed in the report. 
 
Shortcuts

Toolbar:    

5.18. DRAW ARROW COMMAND
Changes the mouse pointer to the Arrow tool, allowing an arrow to be drawn on the report. 
 
Shortcuts

Toolbar:   

5.19. DRAW LINE
Changes the mouse pointer to the Line tool, allowing a line to be drawn on the report. 
 
Shortcuts

Toolbar:   

5.20. DRAW BOX
Changes the mouse pointer to the Box tool, allowing a box to be drawn on the report. 
 
Shortcuts

Toolbar:   

5.20.1. COLOR DIALOG BOX

You can change the color by selecting an alternate color from the Color drop-down list. You can also specify a color, other than 
one in the color list, by specifying the amount of each color component in the Red, Green and Blue fields. In addition, you can use 
the color picker to select from a wider range of colors.
 
The color picker is displayed by clicking on the color palette icon .

6. ZOOM MENU

The Zoom menu includes the following options:

 � Zoom Tool enables the zoom selection tool. 
 � Zoom In increases the zoom magnification. 
 � Zoom Out decreases the zoom magnification. 
 � Zoom Previous zooms to the previous display extents. 
 � Zoom All sets the display extents to include all stored data. 
 � Step Left pans the displayed graph to the left by 10%. 
 � Step Right pans the displayed graph to the right by 10%. 
 � Pan Left pans the displayed graph to the left by 90%. 
 � Pan Right pans the displayed graph to the right by 90%. 
 � Pan To Start pans the displayed graph to the start of the stored data. 
 � Pan To End pans the displayed graph to the end of the stored data. 
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6.1. ZOOM TOOL
Changes the mouse pointer to the zoom selection tool.  This tool allows you to draw a box around the area of a graph to zoom in on.
 
Shortcuts

Toolbar:   

6.2. ZOOM IN
Increases the zoom magnification of the selected graphical frame.
 
Shortcuts

Toolbar:   

6.3. ZOOM OUT
Decreases the zoom magnification of the selected graphical frame.
 
Shortcuts

Toolbar:   

6.4. ZOOM PREVIOUS
Resets the display duration and starting display offset of the selected graphical frame to the previous zoom extents.
 
Shortcuts

Toolbar:   

6.5. ZOOM ALL
Adjusts the starting display time and display duration such that all of the trend data is displayed in the selected graph frame.
 
Shortcuts

Toolbar:  

6.6. STEP LEFT
Sets the display start time for the selected graphical frame to a time 10% less than the current time.  Subtracting a percentage of 
the display duration from the start time does this.  The display duration remains the same.
 
Shortcuts

Toolbar:   

6.7. STEP RIGHT
Sets the display start time for the selected graphical frame to a time 10% greater than the current time.  Adding a percentage of 
the display duration to the start time does this. The display duration remains the same.
 
Shortcuts

Toolbar:   
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6.8. PAN LEFT
Sets the display start time for the selected graphical frame to a time 90% less than the current time.  Subtracting a percentage of 
the display duration from the start time does this. The display duration remains the same.
 
Shortcuts

Toolbar:   

6.9. PAN RIGHT
Sets the display start time for the selected graphical frame to a time 90% greater than the current time. Adding a percentage of 
the display duration to the start time does this. The display duration remains the same.
 
Shortcuts

Toolbar:   

6.10. PAN TO START
Sets the display start time for the selected graphical frame to the start of the saved data.  The display duration (zoom magnifica-
tion) remains the same.
 
Shortcuts

Toolbar:    

6.11. PAN TO END
Sets the display start time for the selected graphical frame to the time of the last data point less the display duration. The display 
duration remains the same.
 
Shortcuts

Toolbar: 

7. INSTRUMENT MENU

The Instrument menu consists of the single option Control Panel. Use this command to open an instrument Control Panel. Control 
Panels are components of DataView that allow you to interact with the instrument. Each instrument family has its own Control Panel.

When you select this option, the Select Instrument dialog box will be displayed. This dialog box will attempt to identify the attached 
instrument. If it is able to identify the attached instrument, the selection for that instrument will be selected automatically. If the 
instrument cannot be identified automatically, the Select Instrument dialog box will remain displayed. If this dialog box remains 
displayed, you must select the appropriate instrument followed by the OK button. Then the Control Panel dialog box specific to 
the instrument will be displayed.
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8. TOOLS MENU

The Tools menu includes the following options:

 � Control Panel Options displays the Control Panel Options dialog box.
 � Directories displays the Default Directories dialog box.
 � General Options displays the General Options dialog box.

8.1. CONTROL PANEL OPTIONS
Use this command to display the Control Panel Options dialog box. This dialog box allows you to specify various defaults associ-
ated with the Control Panel.

The Control Panel Options dialog box allows you to change the default behavior of the Control Panel and set default parameters 
for communication with instruments. The following is a list of available options:

 � Simplified User Interface - placing a check next to this option will cause the Control Panel to automate the download 
process from an instrument.  When the download command is issued with this option enabled the user is not asked to 
specify a file name for the database the recorded data is placed into, the user is not asked to specify session properties 
(the defaults are used), the user is not asked if they want to open the database (it is opened automatically) and finally the 
user is not asked to select a template to be used in opening the database (the default is used).

 � Open previous real-time windows - placing a check next to this option will cause the Control Panel to open and position 
all real-time windows that were open when it was last closed.

 � Automatically connect - placing a check next to this option will cause the Control Panel to use the specified communi-
cation parameters and automatically establish communication with an instrument when opened.  When this option is not 
checked, the communication port and rate drop-down lists are disabled.

 � Supported Instruments - a list containing entries for each of the instruments supported by DataView.

 � Communication port - specifies the default communication port to be used when connecting to the selected instrument.

 � Communication rate - specifies the default communication rate to be used when connecting to the selected instrument. 

8.2. DIRECTORIES
Use this command to change the default directories DataView® uses when storing and retrieving files. This command opens the 
Default Directories dialog box,which allows you to change the default directories DataView® uses when storing and retrieving files.  
When DataView® displays File Open and File Save dialog boxes, the default directory used is determined by the type of file being 
opened or saved and the directories specified in this dialog box. The following is a list of available options:

 � Views: Default directory for report files.
 � Templates: Default directory for template files.
 � Layouts: Default directory for real-time layout files.
 � Database: Default directory for database files.
 � Inst. Config: Default directory for instrument configuration files.

 
The default directory is changed by either entering it into the associated edit box or by using the Browse button. Selecting the 
Browse button will display the Choose Directory dialog box. Use this dialog box to locate the desired directory. Once the directory 
has been located and selected, click on the OK button. The following options allow you to select a desired directory: 

 � Directory name - Type or select the name of the desired directory. Double-clicking on a upper level directory will close 
that list and display directories at the level of the selected directory. Double-clicking on a lower level directory will open 
that directory and display the directories (if any) within it. 

 � Drives - A drop-down list of drives, either local or network mapped, that are currently available on the computer. Once 
another drive is selected, the directory tree will be updated to reflect the directories on that drive.

 � OK - Closes the dialog box and returns to the calling dialog box, changing the directory listed in that dialog box.

 � Cancel - Closes the dialog box without changing the directory in the calling dialog box.
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8.3. GENERAL OPTIONS
Use this command to display the General Options dialog box. The General Options dialog box allows you to change the behavior 
of the main DataView program. The following is a list of available options:

 � Measurement units - allows you to select the measurement format used for worksheets in DataView between English 
and Metric standards.

 � Numeric magnitude format - allows you to select the floating point format for displayed values.  Values can be displayed 
in scientific or magnitude letter indication.

9. WINDOW MENU

The Window menu offers the following commands, which enable you to arrange multiple windows of multiple views in the applica-
tion window:

 � New Window creates a new window that displays the same report. 
 � Cascade arranges windows in an overlapped fashion. 
 � Tile arranges windows in non-overlapped tiles. 
 � Arrange Icons arranges icons of closed windows. 
 � Window 1, 2, ... goes to specified window. 

9.1. NEW
Use this command to open a new window with the same contents as the active window. You can open multiple windows to display 
different parts of a report at the same time. If you change the contents in one window, all other windows containing the same report 
reflect those changes. When you open a new window, it becomes the active window and is displayed on top of all other open windows.

9.2. CASCADE
Use this command to arrange multiple opened windows in an overlapped fashion. 

9.3. TILE
Use this command to arrange multiple opened windows in a non-overlapped fashion.

9.4. ARRANGE ICONS
Use this command to arrange the icons for minimized windows at the bottom of the main window. If there is an open report window at 
the bottom of the main window, then some or all of the icons may not be visible because they will be underneath this report window.

9.5. 1,2, ... COMMAND
DataView® displays a list of currently open report windows at the bottom of the Window menu. A check mark appears in front of 
the name of the active window. Choose a report from this list to make its window active.
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10. HELP MENU

The Help menu offers the following commands, which provide assistance with this application:

 � Contents offers you an index to topics on which you can get help.
 � Register opens the on-line registration form.
 � Update launches your default web browser and directs it to the updates web page for DataView®.
 � About DataView displays the version number of the DataView® application.

10.1. CONTENTS
This help option displays the main help index dialog box. From this starting point, you can find help on all aspects of DataView®.

From the opening screen, you can jump to step-by-step instructions for using DataView® and various types of reference information.

10.2. REGISTER
Use this command to open the on-line registration form. The form is opened using your default web (html) browser. You must have 
a web browser installed and a connection to the Internet available to use this feature.

10.3. UPDATE
Use this command to open the DataView® update web page. The web page contains information about the latest release version 
of DataView®. You must have a web browser installed and a connection to the Internet available to use this feature.

10.4. ABOUT DATAVIEW
Use this command to display the copyright notice and version number of your copy of DataView®.
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Part 2: Designing and Viewing
DataView Reports
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1.   INTRODUCTION TO FRAMES

DataView® frames are rectangular boxes in which graphical items such as lines, text and graphs are drawn. All items displayed 
by DataView® are contained in frames.

1.1. GRAPH FRAME
A Graph Frame provides a graphical look into the database to which it is attached. The database is attached to the frame when 
it is created.
A Graph Frame provides additional tools for viewing the underlying database. These tools provide zoom and pan operation. In 
addition, individual traces and waveform snapshots can be selected using the Select Frame tool.

Normally, the Select Frame tool is used to select a frame for modification. However, in this graph frame it can be used to select 
individual waveforms and trend traces. A trace is selected if any part of it is drawn within a few screen pixels of where the selection 
tool is when the left mouse button is pressed. 

As a trace is selected, handles similar to those of the frame handles are drawn over the trace. If more that one trace is drawn 
within the proximity of the selection tool, when clicked again the next trace will be selected. This will continue until all traces within 
the selection tools proximity have been selected, at which point clicking the left mouse button again will select the first trace and 
the process will repeat.

The Graph Frame can be the parent frame for child frames. The types of child frames that it can support are:

 � Waveform Analysis Frame: When selecting a trace within the graph frame, the attached child frames will be updated 
to reflect the new selection. The types of Waveform Analysis include: Waveform Snapshot, Harmonic Bar Graph and 
Harmonic Text Summary.

 � Graph Legend Frame displays the names of the traces displayed on the graph.

 � Session Summary Frame displays user and instruments supplied information about the session that contains the re-
corded data.

 � Micro-Graph Frame displays a sub-section of the parent frame.

 � Meter Frame displays spot values of a parent frame.

 � Exceedence Statistics Frame: Displays the statistics for an individually selected exceedence trace within the graph area.

 � Exceedence List Frame displays a list of exceedences contained within the attached database.

 � Channel List Frame displays a list of records for selected channels contained within the parent graph frame.

 � Channel Information Frame displays textual information regarding selected channels contained within the parent graph 
frame.

 � Exception List Frame displays a list of exception records for the specified thresholds for the selected channels contained 
within the parent graph frame.

 � Trend Summary List Frame displays a list of sample points for the selected channels contained within the parent graph 
frame.

1.2. LINKED FRAME OVERVIEW
The linking of frames in a report allows you to define one frame by the contents of another frame. For example, an exception 
report frame can be linked to a graph frame which displays the trend data of a recording. The exception report frame can be set 
to list exceptions for the entire recording or just the portion displayed in the graph frame, in which case, zooming in and out of the 
displayed graph will cause the exception report to automatically update based on the displayed data.
 
As another example, a Harmonic Text Summary frame can be linked to a graph displaying waveforms. When a waveform is se-
lected, the Harmonic Text Summary frame will be updated based on the selected waveform.
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In addition, multiple frames can be linked to a single frame. For example, Waveform Snapshot, Harmonic Bar Graph and Harmonic 
Text Summary frames can  be linked to a trend graph that contains waveforms. When we click on and select a waveform, all three 
of the attached frames will automatically be updated for the selected waveform.
 
In the previous example, the trend graph is referred to as the Parent frame. The Waveform Snapshot, Harmonic Bar Graph and 
Harmonic Text summary are Child frames. In DataView®, a parent frame can have multiple child frames, although each child frame 
can only have one parent frame. This means that a child frame cannot be attached to multiple parent frames.
 
Attaching a child frame to a parent creates a hierarchy of linked frames with the top most parent frame controlling the display 
of the lower level frames. Frames that have attached child frames cannot be deleted before all of the attached child frames are 
deleted. This is not something that you have to worry about doing accidentally, as the Cut command is disabled for parent frames 
with attached child frames.
 
The following is a list of parent frames and the type of child frames that can be linked to them: 

 � Graph frame: Waveform Graph, Harmonic Bar Graph, Harmonic Text Summary, Graph Legend, Session Summary, Micro-
Graph, Meter, Exceedence Statistics, Exceedence List and Channel List.

 � Micro-Graph frame: Waveform Graph, Harmonic Bar Graph, Harmonic Text Summary, Graph Legend, Meter, Exceedence 
Statistics, Exceedence List.

2. CREATING FRAMES

Display frames are placed on the worksheet using a frame creation tool. The type of frame created depends on the tool selected 
from the toolbar. The following is a list of available toolbar tools and the type of frame they create:
 

 Graph tool: creates a waveform or trend frame (depending on the data specified).

 Link Frame tool: creates a new frame linked to the currently selected frame.

 Table of Contents tool: creates a Table of Contents frame.

 Text tool: creates a text frame.

 OLE tool: creates an OLE (Object Linking and Embedding) frame.

 Word tool: creates a Word OLE frame.

 Arrow tool: creates an arrow frame.

 Line tool: creates a line frame.

 Box tool: creates a box frame.

 
Each of these frame creation tools creates a specific type of frame.
 

In addition to these tools, the generic Create Frame   tool can be used to create any of the previous types or one that is not 
covered by any of the specific tools. The generic frame tool will ask you to specify the type of frame via a dialog box. The specific 
tools operate in the same manner, except you are not asked to specify the type of frame (it is implied by the specific tool).
 
To create a frame, select one of the frame creation tools by left-clicking the mouse pointer on it. The mouse pointer will change to 
that tool while it is over a valid area of the worksheet. Click and drag to create a frame.



37

2.1. CREATING A GENERIC FRAME
The frame creation tools are used to place a specific type of frame on the worksheet. The tools given on the toolbar provide a shorter 
path to creating these frames. You can use the generic Create Frame tool to place these and other frames on the worksheet. To 
create a frame, perform the following steps:

1. Left-click the mouse pointer on the Create Frame   tool. The mouse pointer will become this tool while it is within 
 the margins of the worksheet.

2. Move the frame tool to the location on the worksheet where the upper left corner of the frame is to be placed.

3. Click and hold the left mouse button.

4. Drag the mouse to the location on the worksheet where the lower right corner of the frame is to be located. As you move
 the mouse pointer, a dotted box is displayed. This dotted box shows the size and location of the frame being created.

5. Release the mouse button. The Frame Type dialog box will be displayed.

6. Select the type of frame to be created from the displayed list.

7. Once the frame type is specified, select the OK button to proceed with the creation of the frame. If you decide not to
 create the frame, select the Cancel button.

8. Once the frame type is specified and the OK button is selected, the corresponding properties dialog box will be displayed.

9. Once the properties have been specified, select the OK button.

2.1.1. FRAME TYPE DIALOG BOX

Specify the type of frame to be created and placed in the box you just created. Once the frame type is selected and the OK button 
pressed, the frame properties dialog box (specific to the specified frame type) will be displayed.

2.1.2. TEXT BOX FRAME

A Text Box frame displays text within a given object frame. The text within the frame is static. It only changes when you change it.

2.1.3. TEXT BOX PROPERTIES DIALOG BOX

This dialog box allows you to specify the text to be displayed in the associated frame. 
 
Type the text you want displayed into the edit window. You can change the font used to display this text by clicking on the Font 
button and specifying the font attributes. As in any text editor, pressing the Enter key will create a new line. Pressing the Tab key 
will position the cursor to the next tab position. You can change the default tab positions by selecting the Tabs button to display 
the Tabs dialog box.
 
You can have DataView® wrap text within the associated frame rectangle by placing a check next to the Enable word wrap option.
 
You can specify if a box should be drawn around the frame, as well. Placing a check in the Draw box around frame option causes 
a box to be drawn around the object frame.
 
You can also have the frame grow with the text by placing a check in the Grow frame with text option. When the Enable word 
wrap and Grow frame with text options are both checked, the width of the frame is maintained and the height is adjusted to fit 
the displayed text. If the Enable word wrap option is disabled and the Grow frame with text is enabled, the width and height of 
the frame will be adjusted to meet the requirements of the displayed text.

2.1.4. TABS DIALOG BOX

The Tabs dialog box allows you to specify the position of tab stops within a text frame.
 
You can specify the default tab position to be every multiple of a given measurement. Specifying a width in the Default tab stops 
field does this.
 
You can also force tab stops at given locations. To do this, enter a value into the Tab stop position field and select the Set button. 
Tab positions will be placed starting with the entries in the list, with each subsequent tab being placed based on the default tab 
stops value.
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You can remove an individually specified tab position by highlighting it and selecting the Clear button. You can also remove all tab 
positions in the list by clicking the Clear All button.

2.2. TEXT FRAME
The following steps describe the process of creating a text frame. To place a text frame on the worksheet, perform the following steps:
 

1. Left-click the mouse pointer on the Place Text   tool. The mouse pointer will become this tool while it is within the
 margins of the worksheet.

2. Move the frame tool to the location on the worksheet where the upper left corner of the frame is to be placed.

3. Click and hold the left mouse button.

4. Drag the mouse to the location on the worksheet where the lower right corner of frame is to be located. As you move the
 mouse pointer, a dotted box is displayed. This dotted box shows the size and location of the frame being created.

5. Release the mouse button. The frame properties dialog box will be displayed.

6. Enter the text box text in the edit field of this dialog box.

7. Specify if word wrap is to be used with this text. Placing a check next to the Enable word wrap check box will enable
 word wrap. When enabled, the specified text will be drawn such that it does not extend beyond the right side of the frame.
 A new line will be started if a word to be displayed will extend beyond the right side of the frame. If word wrap is not
 enabled, the specified text will be drawn on a single line.

8. Specify if a box is to be drawn around the frame. Placing a check next to the draw box around frame check box will
 cause lines to be drawn on each side of the frame.

9. Specify if the frame should be enlarged to the size of the specified text. If word wrap is enabled, the text frame will grow
 down if it is not large enough to contain the text. If word wrap is not enabled, then the frame will grow in width to fit the
 size of the text. If this option is not checked, the frame size will not change to contain the text.

10. Specify the font to be used by clicking on the Font button. The font dialog box will be displayed. Specify the desired font
 name, style, size, effects and script. Once the font attributes are specified, click on the OK button to accept the font. Click
 on the Cancel button to cancel changing the font.

11. Once the desired properties for this new Text frame are specified, select the OK button. The frame will be created using
 the specified properties.

2.3. OLE FRAME
An Object Linking and Embedding (OLE) frame is used to embed items from other applications into a report. The object is contained 
within the specified frame.

The following steps describe the process of creating an OLE (Object Linking and Embedding) frame on the worksheet:
 

1. Left-click the mouse pointer on the Place OLE   tool. The mouse pointer will become this tool while it is within the
 margins of the worksheet.

2. Move the frame tool to the location on the worksheet where the upper left corner of the frame is to be placed.

3. Click and hold the left mouse button.

4. Drag the mouse to the location on the worksheet where the lower right corner of the frame is to be located. As you move
 the mouse pointer, a dotted box is displayed. This dotted box shows the size and location of the frame being created.

5. Release the mouse button. The frame properties dialog box will be displayed. 

6. Specify if it is a new or existing object by clicking on Create New or Create from File, respectively. When creating a new
 object, select the Object Type from the displayed list. When embedding an existing object (Create from File), specify
 the file name. Once specified, select the OK button. If created from a file, the object will be embedded into the worksheet
 and displayed. If creating a new object, the appropriate application will open allowing you to create the new object.
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2.4. WORD OLE FRAME
The following steps describe the process of creating a Word OLE (Object Linking and Embedding) frame on the report:
 

1. Left-click the mouse pointer on the Place Word OLE   tool. The mouse pointer will become this tool while it is
 within the margins of the worksheet.

2. Move the frame tool to the location on the worksheet where the upper left corner of the frame is to be placed.

3. Click and hold the left mouse button.

4. Drag the mouse to the location on the worksheet where the lower right corner of the frame is to be located. As you move
 the mouse pointer, a dotted box is displayed. This dotted box shows the size and location of the frame being created.

5. Release the mouse button. The application registered for editing the .doc file type will be opened.

6. Enter the text you want placed on the report and close the word processor application.

Although this frame is designed to operate with Microsoft Word it should work with any application that is registered (with the operating 
system) to open .doc files. On a system that does not have a word processor installed, Word Pad will be used.  Unfortunately Word 
Pad does not support being an OLE server and will not function as desired.  In this situation the frame will display as an icon and not 
as the actual text entered. If you do not have a word processor installed then use the Text Box frame for placing text in the report.

2.5. ARROW FRAME
An Arrow Frame is used to draw an arrow on a report.

2.5.1. ARROW PROPERTIES DIALOG BOX

The Arrow Properties dialog box allows you to customize the display of the associated arrow. The following steps describe the 
process of creating an Arrow frame:
 

1. Left-click the mouse pointer on the Draw Arrow  tool. The mouse pointer will become this tool while it is within the
 margins of the worksheet.

2. Move the frame tool to the location on the worksheet where the upper left corner of the frame is to be placed.

3. Click and hold the left mouse button.

4. Drag the mouse to the location on the worksheet where the lower right corner of the frame is to be located. As you move
 the mouse pointer a dotted box is displayed. This dotted box shows the size and location of the frame being created.

5. Release the mouse button. The Arrow will be drawn from the point the mouse was pressed to the point it was released,
 with the arrowhead being placed at the point the button was released.

6. Change the arrow properties by right-clicking on the arrow and selecting Properties from the pop-up menu. The
 properties dialog box will be displayed. From this properties dialog box you can specify the line thickness (in pixels), the
 line color and the size of the arrowhead.

7. Once the arrow properties have been specified, select the OK button. To cancel the changes to the arrow select the
 Cancel button.

2.6. LINE FRAME
A Line frame is used to draw a line on a report. The following steps describe the process of creating a Line Frame:
 

1. Left-click the mouse pointer on the Draw Line   tool. The mouse pointer will become this tool while it is within the
 margins of the worksheet.

2. Move the frame tool to the location on the worksheet where the upper left corner of the frame is to be placed.

3. Click and hold the left mouse button.
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4. Drag the mouse to the location on the worksheet where the lower right corner of the frame is to be located. Notice, as you
 move the mouse pointer, a dotted box is displayed. This dotted box shows the size and location of the frame being created.

5. Release the mouse button. The line will be drawn from the upper left to the lower right corners of the frame.

6. Change the line properties by right-clicking on the line and selecting Properties from the pop-up menu. The properties
 dialog box will be displayed. From this dialog box you can specify the line thickness (in pixels) and the line color.

7. Once the line properties have been specified, select the OK button. To cancel the changes to the line, select the Cancel
 button.

2.7. BOX FRAME
A Box Frame is used to draw a rectangular box on a report. The following steps describe the process of creating a Box Frame:
 

1. Left-click the mouse pointer on the Draw Box   tool. The mouse pointer will become this tool while it is within the
 margins of the worksheet.

2. Move the frame tool to the location on the worksheet where the upper left corner of the frame is to be placed.

3. Click and hold the left mouse button.

4. Drag the mouse to the location on the worksheet where the lower right corner of the frame is to be located. As you move
 the mouse pointer a dotted box is displayed. This dotted box shows the size and location of the frame being created.

5. Release the mouse button. The box will be drawn from the upper left to the lower right corners of the frame.

6. Change the box properties by right-clicking on the box and selecting Properties from the pop-up menu. The properties
 dialog box will be displayed. From this properties dialog box you can specify the line thickness (in pixels), the line color
 and the fill style.

7. Once the box properties have been specified select the OK button. To cancel the changes to the box select the Cancel
 button.

2.8. GRAPH FRAME
The following steps describe the process of creating a Graph Frame. The creation of other frame types is identical to this proce-
dure except for the properties dialog box. Each frame type will have its own unique properties dialog box. To place a graph on the 
worksheet, perform the following steps: 

1. Left-click the mouse pointer on the Place Graph   tool. The mouse pointer will become this tool while it is within the
 margins of the worksheet.

2. Move the frame tool to the location on the worksheet where the upper left corner of the frame is to be placed.

3. Click and hold the left mouse button.

4. Drag the mouse to the location on the worksheet where the lower right corner of the frame is to be located. As you move
 the mouse pointer a dotted box is displayed. This dotted box shows the size and location of the frame being created.

5. Release the mouse button. The frame properties dialog box will be displayed.

6. Select a channel to be displayed by highlighting it (left-clicking the mouse pointer) in the Available channels list, then
 click on the Add>> button. The selected channel will be added to the Selected channels list. You can remove channels
 from the selected channel list by highlighting it and clicking on the <<Remove button. You can add all of the available 
 channels to the selected channels list by clicking on the Add All>> button. You can also remove all channels from the
 selected channel list by clicking on the <<Remove All button.

7. You can change the color used to draw each of the channels by highlighting its entry in the selected channel list and
 selecting an alternate color from the Line color drop-down list. You can also specify a color, other than one in the color
 list, by specifying the amount of each color component in the Red, Green and Blue fields.

8. Once the desired properties for this new Graph frame are specified, select the OK button. The frame will be created using
 the specified properties.
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2.8.1. CHANNEL GRAPH PROPERTIES DIALOG BOX

This dialog box consists of three tabs: Channels, Scales, and Template.
 
2.8.1.1 Channels tab
 Select a channel to be displayed by highlighting it (left-clicking the mouse pointer on it) in the Available channels list, then click 
on the Add>> button. The selected channel will be added to the Selected channels list. You can remove channels from the se-
lected channel list by highlighting it and clicking on the <<Remove button. You can add all of the available channels to the selected 
channels list by clicking on the Add All>> button. You can also remove all channels from the selected channel list by clicking on 
the <<Remove All button.

You can change the color used to draw each of the channels by highlighting its entry in the selected channel list and selecting 
an alternate color from the Line color drop-down list. You can also specify a color, other than one in the color list, by specifying 
the amount of each color component in the Red, Green and Blue fields. In addition, you can use the color picker to select from a 
wider range of colors.

The color picker is displayed by clicking on the color palette icon . 

2.8.1.2 Scales tab
The Scales tab allows you to specify how the vertical scales of the associated graph are to be drawn. Two check boxes are pro-
vided with an associated edit box.

Placing a check next to Automatically adjust vertical scale maximum instructs DataView to automatically adjust the upper end 
of the vertical scale to accommodate the displayed channels. Removing the check from this option causes the upper limit of the 
vertical scale to be fixed at the specified value.

Placing a check next to Enable lower limit for vertical scale maximum allows you to specify a value for which the upper end of 
the vertical scale is not allowed to go below.

Placing a check next to Automatically adjust vertical scale minimum instructs DataView to automatically adjust the lower end 
of the vertical scale to accommodate the displayed channels. Removing the check from this option causes the lower limit of the 
vertical scale to be fixed at the specified value.

Placing a check next to Display channel units on graph causes the units for each channel selected for display to be displayed on 
the left side of the graph. When this option is selected you can also over-ride the default channel units and display other text as units.

When Display channel units on graph is selected you can check Display channel units as. Doing so allows you to enter any 
text you would like displayed for the vertical scale units in the edit box to the right.

Placing a check next to Synchronize parent/child frame display period causes all graph frames linked to this frame to zoom 
and pan along with this frame.

Placing a check next to Highlight relative time period of child frames causes this frame to gray the area of the frame relative 
to the child frames display period.

Placing a check next to Automatically adjust Start Date/Time instructs DataView to automatically adjust the starting time in the 
graph for displayed data to the earliest sample point in the data to be displayed. Removing the check allows you to over-ride this 
function and manually specify a starting date and time. It is this date and time that is used when the Zoom All function is selected.

Placing a check next to Automatically adjust Stop Date/Time instructs DataView to automatically adjust the ending time in the 
graph for displayed data to the latest sample point in the data to be displayed. Removing the check allows you to over-ride this 
function and manually specify an ending date and time. It is this date and time that is used when the Zoom All function is selected.

You can also change the font used to display text in the graph by clicking on the Font button and specifying the font attributes.

2.8.1.3 Template tab
 The Template tab allows you to specify how the graph should be treated when it is being opened as part of a template.

Use template defined colors: this option allows you to over-ride the channel colors defined in a database with the colors speci-
fied in the Channel dialog tab.  This option will only work for channels that are listed in the Selected Channels list.  Channels not 
present in that list will use the default color specified in the database.  If this option is not selected the channels will default to the 
colors in the database regardless of the colors selected in the Channel dialog tab.

Delete frame if selected channel list is empty when opening via a template: this option allows you to mark the frame (and all of 
the attached child frames) for deletion if the Selected channels list is empty after opening via a database when used as a template.  
Placing a check next to this option marks the frame for deletion, if empty.  When not checked, the frame will not be deleted even 
if the database does not contain and similar channels (as defined by the Template Filter option).
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Zoom all when opening via template: selecting this option will result in the graph displaying the entire range of samples auto-
matically when the database is opened.  If this option is not selected the display range can be limited by other frames linked to 
the corresponding channel graph.

Template Filter: This option only applies when this report is saved as a template.  It allows you to specify how channels should 
be included when used as a template to display channels stored in a database.  The options available are:

 � Channel Type Only: when selected any channel of the same type (for example voltage waveforms) as those cur-
rently selected for display will be automatically included for display regardless of the channels code and modifier. 
DataView supports the following Channel Types:

  Voltage trend
  Voltage waveform
  Current trend
  Standard resolution surge exceedence
  Standard resolution sag exceedence
  High resolution surge exceedence
  High resolution sag exceedence
  Megohmmeter resistance trend
  Megohmmeter voltage trend
  PowerPad alarm
  PowerPad power
  PowerPad trend
  PowerPad waveform
  PowerPad transient
  Information (text record)
  Bar chart

 � Channel Type and Code: when selected, any channel of the same type and with the same measurement code will be 
automatically included for display regardless of the channels modifier.  A channel code indicates the actual measurement.  
For example, Volts RSM and Volts THD each have the same channel type (Voltage trend) but have different measure-
ment codes.

 � Channel Type, Code and Modifier: when selected, only channels with the same data type, same measurement code and same 
measurement modifier will be automatically included for display.  For example, Volts RMS Min, Volts RMS Max and Volts RMS 
all have the same channel type and channel code.  However they each have a different channel modifier (Min, Max and Avg). 
As an example let us assume that we have the following channels in a database:

  Volts RMS Min
  Volts RMS max
  Volts RMS
  Volts THD Min
  Volts THD Max
  Volts THD
  Voltage Waveform
  Current RMS Min
  Current RMS Max
  Current RMS
  Current THD Min
  Current THD Max
  Current THD
  Current Waveform

We create a graph frame that contains the channels Volts RMS Min only and select the Template Filter option Channel Type Only.  
Then save this report as a template.  Next, if we open the sample database with this template we will have the following channels 
selected for display automatically:
  Volts RMS Min
  Volts RMS Max
  Volts RMS
  Volts THD Min
  Volts THD Max
  Volts THD

The reason for this is that all these channels share the same channel type (Voltage trend).  If we had specified Channel Type and 
Code for the Template Filter, the following channels would have been selected for display automatically.
  Volts RMS Min
  Volts RMS Max
  Volts RMS
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The reason for this is that these channels all have the same type and code. The only difference being the modifier (min, max or 
avg). Finally, if we had selected the Channel Type, Code and Modifier template filter option, only Volts RMS Min channel would 
have been displayed.

Using the Template Filter option, you can widen or narrow the list of channels that will be included. You can create a template that 
only displays minimum channels by specifying the proper filter option.

Once the desired properties for this new Graph frame are specified, select the OK button. The frame will be created using the 
specified properties.

2.9. LINKED FRAME
A linked frame is a frame that obtains its display data from a parent frame. Linking frames allows interaction between the linked 
frames. For more information about linked frames see Linked Frame Overview.

To link a frame to another, perform the following steps:
 

1. Select the frame to be linked using the frame selection tool . The selected frame will be displayed with resize
 handles. Both the Link Frame menu option and the Link Frame tool are enabled only when a frame capable of being
 aparent (able to support child frames) is selected. If the selected frame can not support child frames, the menu option
 and toolbar icon will be grayed.

2. Select Link Frame from the Edit menu or the Link Frame tool   from the toolbar. The Child Frame Type dialog box
 will be displayed. The Child Frame Type dialog box allows you to specify the type of frame to be created and linked to
 the previously selected parent frame. The Type list contains only child frame types, which can be linked to the selected
 parent frame.

3. Select the type of child frame to be created and linked from the Type list.

4. Once the child frame type is specified, select the OK button to proceed with the creation and linking of the frames. If you
 decide not to create the frame, select the Cancel button. After selecting OK the cursor will change to the Linked frame
 creation tool.

5. Move the frame tool to the location on the worksheet where the upper left corner of the frame is to be placed.

6. Click and hold the left mouse button.

7. Drag the mouse to the location on the worksheet where the lower right corner of the frame is to be located. As you move
 the mouse pointer a dotted box is displayed. This dotted box shows the size and location of the frame being created.

8. Release the mouse button. The Properties dialog box specific to the type of linked frame previously specified will be
 displayed.

9. Once the properties have been specified, select the OK button. The child frame is created and linked to the parent frame
 selected in step 1 above.

 
This procedure creates a hierarchy of linked frames with the top most parent frame controlling the display of the lower level frames.

2.10. GRAPH LEGEND FRAME
The Graph Legend Frame is a child frame linked to the Graph Frame. The Graph Legend frame displays the names of the recorded 
channels displayed in its parent graph frame. The name of each displayed channel is preceded by a short line segment drawn in 
the same color as its associated trace.

The Graph Legend Properties dialog box is used to customize the way the Graph Legend frame is displayed.
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This dialog box has two options:

 � Draw box around frame
 � Display channel units

 
When the Draw box around frame option is checked, a box is drawn around the Graph Legend frame. To prevent a box from being 
drawn, remove the check mark. 

2.11. WAVEFORM ANALYSIS FRAME
The Waveform Analysis Frame is a child frame linked to either a Channel Graph or Micro-Graph frame. The Waveform Analysis 
frame displays the waveform selected in its parent frame. The waveform can be displayed in the following forms:

 � Waveform Snapshot displays the selected waveform.
 � Harmonic Bar Graph displays a harmonic bar graph of the selected waveform.
 � Harmonic Text displays a harmonic text summary of the selected waveform.

The type of waveform analysis is specified in the Waveform Analysis Properties dialog box. This dialog box is displayed either 
by double-clicking the left mouse button while the frame selection tool is over the desired frame, or by selecting Properties from 
the pop-up menu. right-clicking the mouse button with the frame selection tool over the desired frame displays the pop-up menu.
 
In addition to the analysis type, you can specify if the harmonic text summary is to display values in RMS, peak amplitude or percent 
of fundamental. Selecting the appropriate radio button in the Individual Harmonics group box does this.
 
You can quickly move between captured waveforms (selected for display) using the pan commands. Selecting Pan To Start displays 
the first captured waveform. Selecting Pan To End displays the last captured waveform. Selecting the Step Right or Step Left 
displays the next or previously captured waveform. When stepping through the captured waveforms, the selection will move from 
each waveform for the channel associated with the currently displayed waveform. After the last waveform for the current channel, 
the first (or last depending on direction of stepping) waveform for the next (or previous) channel will be displayed.
 
Placing a check in the Zoom parent frame when panning will cause the parent graph to zoom to the time period associated with 
the newly selected waveform. If the parent frame is a Micro-Graph, then the auto zooming function will result in the Micro-Graphs 
frames parent being updated (gray area) to display the relative time and location of the selected waveform.
 
You can also freeze the data displayed by the analysis frame at its current state by placing a check in the Lock frame data field 
of the Waveform Analysis Properties dialog box. 

2.11.1. WAVEFORM ANALYSIS PROPERTIES DIALOG BOX

The Waveform Analysis Properties dialog box is used to specify the type of waveform analysis and to specify various display op-
tions. The options available are:
 

 � Analysis Type contains a group of radio buttons, which specifies the type of analysis to be performed on the associated 
waveform.

 � Individual Harmonics contains a group of radio buttons, which specifies how the individual harmonics are displayed in a 
Harmonic Text Summary. The values can be displayed as RMS, peak amplitude or percent of fundamental.

 � Zoom parent frame when panning is a check box, which when selected causes the parent frame to zoom to the time 
period associated with the displayed waveform. This occurs when issuing a pan command while the waveform analysis 
frame is selected.

 � Lock frame data is a check box, which freezes the data used to display the frame at their current values. When the frame 
data is locked, selecting a waveform in the parent frame does not change the data displayed in this child frame. 

 � OK button closes the dialog box and saves changes you have made. 

 � Cancel button closes the dialog box without saving any changes you have made. 

2.12. SESSION SUMMARY FRAME
The Session Summary Frame is a child frame linked to the Graph Frame. The Session Summary frame displays a textual summary 
of its parent frame. You can customize the summary text displayed using the Session Summary Properties Dialog box. This summary 
text is obtained from the Session Summary information entered at the time the recorded channel data was saved to the database.
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The Session Summary frame contains static and dynamic text. Static text is displayed as it was typed into the Session Summary 
Properties dialog box. Dynamic text is generated through field substitution. The value of the parent frame of the specified field is 
substituted for the field name.

Surrounding the session summary field name with square brackets specifies dynamic text. For example, if the Operator Company 
Name field of the recorded data is AEMC® Instruments Chauvin Arnoux® Inc., placing the text [Operator Company Name] in 
the Summary Text edit box will result in AEMC® Instruments Chauvin Arnoux® Inc. being displayed in its place on the worksheet.

Dynamic text substitution is useful for templates that create a report when session data is attached. The field name will reflect the 
name contained in the attached database (which may be different from database to database). 

2.12.1. SESSION SUMMARY PROPERTIES DIALOG BOX

The Session Summary Properties dialog box allows you to specify what is displayed in its associated Session Summary Frame.

This dialog box contains an edit box into which you type the static and dynamic text to be displayed in the Session Summary Frame. 
It also contains a list box from which you can select field names, field values and field codes.

Static text is displayed as it is typed into the Summary Text edit box. Dynamic text is generated through field substitution. The value 
of the specified field as obtained from the Session Summary Frames parent is substituted for the field name.

Surrounding the Session Summary field name with square brackets specifies dynamic text. For example, if the Operator Company 
Name field of the recorded data is AEMC Instruments® Chauvin Arnoux® Inc., placing the text [Operator Company Name] in 
the Summary Text edit box will result in AEMC Instruments® Chauvin Arnoux® Inc. being displayed in its place on the worksheet.
 
Dynamic text substitution is useful for templates that create a report when session data is attached. The field name will reflect the 
name contained in the attached database (which may be different from database to database).
 
Session Summary Fields can be added to the Summary Text in a number of ways. First, place the cursor in the Summary Text 
edit box where the Summary Field is to be inserted. Next, click on the Session Summary Field (in the list box) to be inserted. The 
next step depends on what you want to insert. To insert the field name as static text, click on the Insert Field Name button (notice 
brackets are not placed around the field name). To insert the field value as static text, click on the Insert Field Value button (notice 
that the value displayed in the list box is inserted). To insert the field value as dynamic text, click on the Insert Field Code button 
(notice that the name of the field surrounded by square brackets is inserted).
 
If the selected Field does not have a current value associated with it, the Insert Field Value button will be grayed and unavailable.
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As in any text editor, pressing the Enter key will create a new line. Pressing the Tab key will position the cursor to the next tab 
position. You can change the default tab positions by selecting the Tabs button to display the Tabs dialog box.
 
You can also change the font used to display this text by clicking on the Font button and specifying the font attributes.  

2.13. LINKED-GRAPH FRAME
A Linked-Graph Frame provides a graphical look into the database attached to its parent frame. As with the Channel Graph Frame, 
the Linked-Graph frame provides tools for viewing the underlying database. These tools provide zoom and pan operations. The 
parent Channel Graph frame will gray the area of its graph window to represent the time period being displayed by this child frame. 
As you zoom and pan the Linked-Graph frame, the parent Channel Graph will update the grayed area of its graph. This provides 
a quick reference into the Macro view (parent graph) of the graph that this Linked-Graph is displaying.

Normally, the Select Frame tool is used to select a frame for modification. However, in this graph frame it can be used to select 
individual waveforms and trend traces. A trace is selected if any part of it is drawn within a few screen pixels of where the selection 
tool is when the left mouse button is pressed. 

As a trace is selected, handles similar to those of the frame handles, are drawn over the trace. If more than one trace is drawn 
within the proximity of the selection tool, when clicked again, the next trace will be selected. This will continue until all traces within 
the selection tools proximity have been selected, at which point clicking the left mouse button again will select the first trace and 
the process will repeat.

The Linked-Graph Frame can be the parent frame for child frames. The types of child frames that it can support are:

 � Waveform Analysis Frame: When selecting a trace within the graph frame, the attached child frames will be updated 
to reflect the new selection. The types of Waveform Analysis include: Waveform Snapshot, Harmonic Bar Graph and 
Harmonic Text Summary.

 � Graph Legend Frame displays the names of the traces displayed on the graph.

 � Meter Frame displays spot values of a parent frame.

 � Exceedence Statistics Frame displays the statistics for an individually selected exceedence trace within the graph area.

 � Exceedence List Frame displays a list of exceedences contained within the attached database.

2.13.1. LINKED-GRAPH PROPERTIES DIALOG BOX

This dialog box consists of three tabs: 

 �  Channels tab: Placing a check in the Display channels selected in parent graph option causes the Linked-Graph 
frame to automatically display the same channels selected in the parent graph frame. Removing the check from this 
option allows you to customize the display of channels in the frame. While this option is enabled, the remaining options 
on this worksheet of the dialog box are disabled. This option must be disabled to allow the customization of the associ-
ated frame using the fields on this worksheet of the dialog box. 
 
Select a channel to be displayed by highlighting it (left-clicking the mouse pointer on it) in the Available channels list, 
then click on the Add>> button. The selected channel will be added to the Selected channels list. You can remove 
channels from the selected channel list by highlighting it and clicking on the <<Remove button. You can add all of the 
available channels to the selected channels list by clicking on the Add All>> button. You can also remove all channels 
from the selected channel list by clicking on the <<Remove All button. 
 
You can change the color used to draw each of the channels by highlighting its entry in the selected channel list and 
selecting an alternate color from the Line color drop-down list. You can also specify a color, other than one in the color 
list, by specifying the amount of each color component in the Red, Green and Blue fields. In addition, you can use the 
color picker to select from a wider range of colors. 
 
The color picker dialog box is displayed by clicking on the color palette icon .

 � Scales tab is described in Section 2.8.1.2.

 � Template tab is described in Section 2.8.1.3.
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2.14. METER FRAME
A Meter Frame provides a textual summary of the samples within one pixel of its parent frame. The finest resolution, which the parent 
frame can draw, is one screen (or printer) pixel. Depending on the display magnification, one pixel width can contain one or more 
sample points. In addition, the time associated with each pixel position is dependent on the zoom magnification and display offset.

A vertical line is displayed in the parent frame at the pixel position associated with the current meter time. As you pan left and right, 
this vertical line will move to reflect the new position of the meter. Selecting Pan To Start moves the meter to the first pixel position 
of the parents graph. Selecting Pan To End moves the meter to the last pixel position. Pan Left and Pan Right step the meter 
up to 10 pixels left and right, respectively. Step Left and Step Right moves the meter position 1 pixel left and right, respectively.

The information displayed in the Meter frame includes the time associated with the pixel position of the parent graph frame. It also 
displays the minimum, maximum and average values of the samples for each displayed channel for the associated single pixel time 
period. In addition, a short line of the same trace color and name of the associated parent frame trace is displayed alongside the 
measurement values. Also, the number of samples within the single pixel time period is indicated at the end of each trace name.

2.14.1. METER PROPERTIES DIALOG BOX

The Meter Properties dialog box allows you to customize the display of the meter frame. Placing or removing the check next to 
each of the following options enables and disables the display of the associated parameter.
 

 � Start time when checked, the start time for the meter in the associated graph is displayed. 
 � Duration when checked, the duration of the meter line in the associated graph is displayed.
 � Minimum value when checked, the minimum value in the sample set is displayed.
 � Maximum value when checked, the maximum value in the sample set is displayed.
 � Average value when checked, the average value in the sample set is displayed.
 � First sample value when checked, the value of the first sample in the sample set is displayed.
 � Number of samples when checked, the number of samples in the sample set is displayed.

2.15. EXCEEDENCE STATISTICS FRAME
The Exceedence Statistics frame is a child frame linked to either a Channel Graph of Micro-Graph frame. The Exceedence Statistics 
frame displays a textual summary of the exceedence trace selected in its parent frame.  You can customize the text displayed 
using the Exceedence Statistics Properties dialog box. The displayed text is obtained from the exceedence trace selected in the 
parent frame.

The Exceedence Statistics frame contains static and dynamic text. Static text is displayed as it was typed into the Exceedence 
Statistics Properties dialog box. Dynamic text is generated through field substitution. The value obtained from the parent frame of 
the specified field is substituted for the field name.

Surrounding the exceedence statistics field name with square brackets, specifies dynamic text. For example, if the Exceedence 
Type field of the selected exceedence trace is Sag, placing the text [Exceedence Type] in the Exceedence Statistics Text edit box 
will result in Sag being displayed in its place on the worksheet.

Dynamic text substitution is useful for templates that create a report when recorded data is attached to it. The field name will reflect 
the name contained in the attached database, which may be different from database to database.

You can pan quickly between exceedence captures selected for display. Selecting Pan To Start displays the first exceedence 
event. Selecting Pan To End displays the last captured exceedence event. Selecting Step Right or Step Left displays the next 
or previously captured event.

When stepping through the captured exceedence events, the selection will move from each exceedence for the channel associated 
with the currently displayed event. After the last event for the current channel, the first (or last depending on direction of stepping) 
event for the next (or previous) channel will be displayed.

Enabling Zoom parent frame when panning (see Exceedence Statistics Properties dialog box) will cause the parent graph to 
zoom to the time period associated with the newly selected event. If the parent frame is a Micro-Graph then the auto zooming 
function will result in the Micro-Graphs frames parent being updated (gray area) to display the relative time and location of the 
selected waveform. 
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2.15.1. EXCEEDENCE STATISTICS PROPERTIES DIALOG BOX

The Exceedence Statistics Properties dialog box allows you to specify what is displayed in its associated Exceedence Statistics 
frame. The first tab of the Exceedence Statistics Properties dialog box is illustrated in the following figure:

This tab of the dialog box contains an edit box into which you type the static and dynamic text to be displayed in the Exceedence 
Statistics frame. It also contains a list box from which you can select field names, field values and field codes.

Static text is displayed as it is typed into the Text edit box. Dynamic text is generated through field substitution. The value of the 
specified field as obtained from the Exceedence Statistics frames parent is substituted for the field name.

Surrounding the exceedence statistics field name with square brackets, specifies dynamic text. For example, if the Exceedence 
Type field of the selected exceedence trace is Sag, placing the text [Exceedence Type] in the Exceedence Statistics Text edit box 
will result in Sag being displayed in its place on the worksheet.

Dynamic text substitution is useful for templates, which create a report when session data is attached to it. The field name will 
reflect the name contained in the attached database, which may be different from database to database.

Exceedence Statistics fields can be added to the Text edit box in a number of ways. First, place the cursor in the Text edit box were 
the Exceedence Statistics field is to be inserted. Next, click on the Exceedence Statistics field (in the list box) to be inserted. The 
next step depends on what you want inserted. To insert the field name as static text, click on the Insert Field Name button (notice 
brackets are not placed around the field name). To insert the field value as static text, click on the Insert Field Value button (notice 
that the value displayed in the list box is inserted). To insert the field value as dynamic text, click on the Insert Field Code button 
(notice that the name of the field surrounded by square brackets is inserted).

If the selected Field does not have a current value associated with it, the Insert Field Value button will be grayed and unavailable.

As in any text editor, pressing the Enter key will create a new line. Pressing the Tab key will position the cursor to the next tab 
position. You can change the default tab positions by selecting the Tabs button. This will display the Tabs dialog box.

You can also change the font used to display this text by clicking on the Font button and specifying the font attributes.
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Additional display attributes are selected on the dialog box’s second properties tab. This tab is illustrated in the following figure:

This tab of the dialog box allows you to select the type of exceedence to select when performing panning operation. You can select 
Surge, Sag or both.

Placing a check in the Zoom parent frame when panning will enable automatic zooming of the parent graph when stepping 
through exceedence events.

2.16. EXCEEDENCE LIST FRAME
The Exceedence List frame is a child frame linked to either a Channel Graph or Micro-Graph frame. The Exceedence List frame 
displays a textual list of the exceedence records in the database attached to its parent frame. You can customize the text displayed 
using the Exceedence List Properties dialog box. The displayed text is obtained from the exceedence records in the recorded data 
contained within the parent frame.

You can step between exceedence list entries. Selecting Pan To Start displays the first exceedence event. Selecting Pan To End 
displays the last captured exceedence event. Selecting Step Right or Step Left displays the next or previously captured event.

When stepping through the captured exceedence events, the selection will move from each exceedence for the channel associated 
with the currently displayed event. After the last event for the current channel, the first (or last depending on direction of stepping) 
event for the next (or previous) channel will be displayed.

In addition to stepping through the list with the tool bar, you can select a specific event listed using the mouse pointer. The text for 
the selected event will be highlighted, indicating which event in the list is currently selected.

Enabling Zoom parent frame on selection (see Exceedence List Properties dialog box) will cause the parent graph to zoom to 
the time period associated with the newly selected event.  If the parent frame is a Micro-Graph, then the auto zooming function will 
result in the Micro-Graph frame’s parent being updated (gray area) to display the relative time and location of the selected waveform.

2.16.1. EXCEEDENCE LIST PROPERTIES DIALOG BOX

The Exceedence List Properties dialog box allows you to specify what is displayed in its associated Exceedence List Frame. This 
dialog box consists of three tabs: 

 � Format
 � Scrolling 
 � Parameters
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2.16.1.1 Format tab
This tab allows you to select the type of exceedence to filter when building the exceedence list. You can select Surge, Sag or both.
 
You can also specify the sort order when displaying the exceedence events. To change the sort order, select an item in the Sort 
Order list and select the Prompt or Demote button. Entries higher in the list will have a higher priority. Entries lower in the list will 
have a lower priority.
 
The list can be displayed (sorted) in either descending or ascending order. This primary order is specified via the radio buttons in 
the Sort Type radio group.
 
You can also limit the number of entries displayed in the list by entering a value in the List size limit dialog field.

2.16.1.2 Scrolling
Enable scrolling: placing a check next to this option causes the frame to only display the specified number of lines.  Scroll bars 
are displayed along the right side of the frame to move through the list.
 
Window size: specifies the maximum number of lines to be display in the frame for scrolling.
 
Placing a check in the Zoom parent frame on selection will enable automatic zooming of the parent graph when stepping through 
or selecting exceedence events.

2.16.1.3 Parameters
The actual parameters displayed are selected on the dialog’s second properties tab. This tab of the dialog box contains a list of 
available parameters and a list of selected parameters. The entries in the Selected parameters list are the items displayed on 
each line of the list. A parameter is added to the Selected parameters list by highlighting the desired parameter in the Available 
parameter list and pressing the Add>> button. Parameters are removed from the Selected parameter list by selecting the desired 
entry and pressing the <<Remove button.
 
Parameters can be moved up or down in the Selected parameters list by selecting the desired entry and pressing the Promote or 
Demote buttons. Parameters higher in the list are displayed before entries lower in the list. Promoting an entry moves it closer to 
the start of the displayed line. Demoting an entry moves it closer to the end of the displayed line.
 
The width of each column (parameter entry) can be automatically adjusted or you can specify a fixed width. To have the width of all 
columns automatically adjusted, place a check next to the Auto Width option.  If you want to specify a fixed column width, remove 
the check from the Auto Width option, then select the parameter and specify a width in the Field Width edit box. The Field Width 
edit box sets the width for the selected parameter. You must select each parameter in turn to set its associated column width.
 
Selecting a parameter and then specifying the desired alignment can specify the horizontal alignment of each parameter. Each 
parameter has its own associated alignment. You must select each parameter in turn to change their associated column alignment.
 
A box can be drawn around the resulting list table by placing a check next to the Draw box around frame option. Removing the 
check from this option prevents the box for being drawn.
 
A grid can be drawn between each column and row of the table by placing a check next to the Draw grid option. Removing the 
check from this option prevents the grid from being drawn.
 
You can disable the relative highlighting of a parent graph by placing a check next to the Disable relative highlight of parent 
frame option. When not checked, the parent graph will highlight the region of the graph corresponding to the start time and dura-
tion of the selected list entry.
 
You can also change the font used to display this text by clicking on the Font button and specifying the font attributes.
 
The Make Default button allows you to save the currently selected parameter list for future recall. Selecting the Make Default 
button saves the currently selected parameters, tab positions and text font into the Windows registry.
 
The Load Default button allows you to recall a previously saved parameter list, tab positions and text font.
 
Only a single default configuration can be saved at one time. Selecting the Make Default button overwrites the previous default 
configuration.

2.17. EXCEPTION LIST FRAME
The Exception List frame is a child frame linked to either a Channel Graph or Micro-Graph frame. The Exception List frame displays 
a textual list summary of the sample points for a given channel, which exceed user-specified thresholds. You can customize the 
text displayed using the Exception List Properties dialog box. The displayed text is obtained from the exceedence records in the 
recorded data contained within the parent frame.
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You can step between exception list entries. Selecting Pan To Start displays the first exception entry. Selecting Pan To End dis-
plays the last exception entry. Selecting Step Right or Step Left displays the next or previous list entry.

When stepping through the captured exception entries the selection will move from each exception for the associated channel.

In addition to stepping through the list with the tool bar, you can select a specific entry listed using the mouse pointer. The text for 
the selected entry will be highlighted, indicating which entry in the list is currently selected.

Enabling Zoom parent frame on selection (see Exception List Properties dialog box) will cause the parent graph to zoom to the 
time period associated with the newly selected entry.  If the parent frame is a Micro-Graph, then the auto zooming function will result 
in the Micro-Graph frame’s parent being updated (gray area) to display the relative time and location of the selected waveform.

2.17.1. EXCEPTION LIST PROPERTIES DIALOG BOX

The Exception List Properties dialog box allows you to specify what is displayed in its associated Exception List frame. This dialog 
box includes two tabs:

2.17.1.1  Format tab
This tab of the dialog box allows you to specify the channel and limits to be used in creating the exception report. The items in 
this dialog box are defined as follows:

Database: Indicates the name of the database containing the recorded channel data. It is available for information only and is 
obtained from the parent trend graph.

Selected trace: When selected, the exception report will be generated for the trace selected in the parent frame. When another 
trace is selected in the parent frame, the exception report will be updated to reflect the measurements of the newly selected trace.

Available channels: A list of the channels contained in the parent graph’s database. Select the channel to be used in the excep-
tion report. Only a single channel can be selected at one time. While Selected trace is checked you will not be able to select an 
entry in this list.

Show all: A check box, which acts as a filter mechanism. When checked, all the recorded channels contained within the parents 
database are displayed. When not checked, only the channels, which have been selected for display in the parent graph are dis-
played. While Selected trace is checked, this option is disabled and you will not be able to select this item.

Lock frame data: When checked, the displayed exception report becomes static. Changes to the parent frame do not affect the 
exception report. When not checked, changes to the parent frame (as will be described shortly) affect the exception report.

Limit list to parent display frame: When checked, the exception report is limited to the zoomed section of the parent graph frame. 
When not checked, the entire time frame of the recorded channel is included in the exception report.

Zoom parent frame on selection: When checked, the parent graph is automatically zoomed to the time period associated with 
the newly selected entry. If the parent frame is a Micro-Graph, then the auto zooming function will result in the Micro-Graph frame’s 
parent being updated (gray area) to display the relative time and location of the selected list entry.

Exception filter: A set of radio buttons that define how the specified limits are to be used. They are defined as follows:

 � Above upper limit: When selected, only the upper limit is used. The lower limit edit box is disabled and grayed. If the 
Inclusive check box is selected, the exception report includes measurements equal to and above the upper limit. When 
the Inclusive check box is not selected, the exception report includes only values above the upper limit.

 � Below lower limit: When selected, only the lower limit is used. The upper limit edit box is disabled and grayed. If the 
Inclusive check box is selected, the exception report includes measurements equal to and below the lower limit. When 
the Inclusive check box is not selected, the exception report includes only values below the lower limit.

 � Within upper and lower limits: When selected, both the upper and lower limit edit boxes are enabled. If the Inclusive 
check box is selected, the exception report includes measurements that are equal to or greater than the lower limit and 
lower than or equal to the upper limit. When the Inclusive check box is not selected, only values that are greater than the 
lower limit and less than the upper limit are included.

 � Outside upper and lower limits: When selected, both the upper and lower limit edit boxes are enabled. If the Inclusive 
check box is selected, the exception report includes measurements that are equal to the lower limit, or less than the lower 
limit, or equal to the upper limit, or greater than the upper limit. When the Inclusive check box is not selected, only values 
that are less than the lower limit or greater than the upper limit are included.

Inclusive: When checked, the exception report includes the specified limits. When not checked, the exception report does not 
include the limit values. See Exception type above for more.
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Get limits from database: Some instruments (such as the PowerPad or Qualistar) specify upper and lower exception limits when 
the database is created.  When this option is checked and the limits are specified in the database, then those limits will be used.  If 
the limits are not specified in the database, then the limits specified here will be used.  When not checked, only the limits specified 
here will be used even if they are specified in the database.
 
Upper limit: Specifies the upper limit of the exception report. See Exception type above for more.
 
Lower limit: Specifies the lower limit of the exception report. See Exception type above for more.
 
Display limit bands: placing a check next to this option causes horizontal lines at the specified limit ranges to be displayed on 
the parent graph.
 
Limit color: specifies the color of the limit bars to be displayed on the parent graph.

Scrolling
 � Enable scrolling: placing a check next to this option causes the frame to only display the specified number of lines.  Scroll 

bars are displayed along the right side of the frame to move through the list.
 � Window size: specifies the maximum number of lines to be display in the frame for scrolling.

 
When the Limit list to parent display frame check box is selected, any change to the zoomed state of the parent graph window 
will result in the exception report being updated for the selected time frame.
 
By combining the Limit list to parent display frame and Selected trace options, the exception report will become dynamic. The 
associated channel and time frame are updated as you interact with the parent frame graph.
 
Placing a check next to Lock frame data, results in the exception report becoming static. The dynamic nature of the report is 
disabled when the Lock frame data option is checked.

2.17.1.2 Parameters
The actual parameters displayed are selected on the dialog’s second properties tab. This tab of the dialog box contains a list of 
available parameters and a list of selected parameters. The entries in the Selected parameters list are the items displayed on 
each line of the list. A parameter is added to the Selected parameters list by highlighting the desired parameter in the Available 
parameter list and pressing the Add>> button. Parameters are removed from the Selected parameter list by selecting the desired 
entry and pressing the <<Remove button.
 
Parameters can be moved up or down in the Selected parameters list by selecting the desired entry and pressing the Promote or 
Demote buttons. Parameters higher in the list are displayed before entries lower in the list. Promoting an entry moves it closer to 
the start of the displayed line. Demoting and entry moves it closer to the end of the displayed line.
 
The width of each column (parameter entry) can be automatically adjusted or you can specify a fixed width.  To have the width of all 
columns automatically adjusted, place a check next to the Auto Width option.  If you want to specify a fixed column width, remove 
the check from the Auto Width option, then select the parameter and specify a width in the Field Width edit box.  The Field Width 
edit box sets the width for the selected parameter.  You must select each parameter in turn to set its associated column width.
 
Selecting a parameter and then specifying the desired alignment can specify the horizontal alignment of each parameter.  Each 
parameter has its own associated alignment. You must select each parameter in turn to change their associated column alignment.
 
A box can be drawn around the resulting list table by placing a check next to the Draw box around frame option.  Removing the 
check from this option prevents the box for being drawn.
 
A grid can be drawn between each column and row of the table by placing a check next to the Draw grid option.  Removing the 
check from this option prevents the grid from being drawn.
 
You can disable the relative highlighting of a parent graph by placing a check next to the Disable relative highlight of parent 
frame option.  When not checked, the parent graph will highlight the region of the graph corresponding to the start time and dura-
tion of the selected list entry.
 
You can also change the font used to display this text by clicking on the Font button and specifying the font attributes.
 
The Make Default button allows you to save the currently selected parameter list for future recall. Selecting the Make Default 
button saves the currently selected parameters, tab positions and text font into the Windows registry.
 
The Load Default button allows you to recall a previously saved parameter list, tab positions and text font.
 
Only a single default configuration can be saved at one time. Selecting the Make Default button over writes the previous default 
configuration.
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2.18. TREND SUMMARY LIST FRAME
The Trend Summary List frame is a child frame linked to either a Channel Graph or Micro-Graph frame. The Trend Summary List 
frame displays a textual list summary of the sample points for a given channel.  Each summary line contains the minimum, maximum 
and average values of a group of sample points.  You can specify the number of samples to be summarized, as well as, customize 
the text displayed using the Trend Summary List Properties dialog box. The displayed text is obtained from the combined sample 
points in the recorded data contained within the parent frame.
 
You can step between list entries. Selecting Pan To Start displays the first list entry. Selecting Pan To End displays the last list 
entry. Selecting Step Right or Step Left displays the next or previous list entry.
 
When stepping through the captured list entries, the selection will move from each entry for the associated channel.
 
In addition to stepping through the list with the tool bar, you can select a specific entry listed using the mouse pointer. The text for 
the selected entry will be highlighted, indicating which entry in the list is currently selected.
 
Enabling Zoom parent frame on selection (see Trend Summary List Properties dialog box) will cause the parent graph to zoom to 
the time period associated with the newly selected entry. If the parent frame is a Micro-Graph, then the auto zooming function will 
result in the Micro-Graph frame’s parent being updated (gray area) to display the relative time and location of the selected waveform. 

2.18.1. TREND SUMMARY LIST PROPERTIES DIALOG BOX

The Trend Summary List Properties Dialog Box allows you to specify what is displayed in its associated Trend Summary List frame. 
This dialog box consists of two tabs.

2.18.1.1 Channels tab
Trend Summary List Properties Dialog Box allows you to specify what is displayed in its associated Trend Summary List frame. 
This tab of the dialog box allows you to specify the summary options available for the Trend Summary report. The items in this 
dialog box are defined as follows:
 
Database: Indicates the name of the database containing the recorded channel data. It is available for information only and is 
obtained from the parent trend graph.
 
Selected trace: When enabled, the trend summary report will be generated for the trace selected in the parent frame. When 
another trace is selected in the parent frame, the report will be updated to reflect the measurements of the newly selected trace.
 
Show all: A check box, which acts as a filter mechanism. When checked, all the recorded channels contained within the parent’s 
database are displayed. When not checked, only the channels that have been selected for display in the parent graph are displayed. 
While Selected trace is checked, this option is disabled and you will not be able to select this item.
 
Available channels: A list of the channels contained in the parent graph’s database. Select the channel to be used in the trend 
summary report. Only a single channel can be selected at one time. While Selected trace is checked, you will not be able to select 
an entry in this list.
 
Lock frame data: When checked, the displayed trend summary report becomes static. Changes to the parent frame do not affect 
the trend summary report. When not checked, changes to the parent frame (as will be described shortly) affect the trend summary 
report.
 
Zoom parent frame on selection: When checked, the parent graph is automatically zoomed to the time period associated with 
the newly selected entry. If the parent frame is a Micro-Graph, then the auto zooming function will result in the Micro-Graph frame’s 
parent being updated (gray area) to display the relative time and location of the selected list entry.
 
Limit summary to parent window: When checked, the trend summary report is limited to the zoomed section of the parent graph 
frame. When not checked, the entire time frame of the recorded channel is included in the trend summary report.
 
Summary Type: A set of radio buttons, which define how the sample points are to be combined when generating the report. They 
are defined as follows:

 � Average by sample count: When selected, the value contained in the associated edit box is used to indicate the number 
of samples that are combined for each list entry. For example, if this option is selected and the edit box contains 10, every 
10 samples will be compared for the minimum and maximum values to display in a list entry. Also, the 10 samples will be 
averaged for each list entry.

 � Average by sample period: When selected, the time period contained in the associated drop-down list is used to indicate 
the number of samples that are combined for each list entry. The actual number of samples combined will depend on the 
storage rate of the recorded data. For example, if the recorded data were stored at 1-second intervals and a 1-minute 
averaging is selected, 60 samples will be combined for each summary list entry.
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Scrolling

 � Enable scrolling: placing a check next to this option causes the frame to only display the specified number of lines.  Scroll 
bars are displayed along the right side of the frame to move through the list.

 � Window size: specifies the maximum number of lines to be display in the frame for scrolling.
 
When the Limit summary to parent window check box is selected, any change to the zoomed state of the parent graph window 
will result in the trend summary report being updated for the selected time frame. By combining the Limit summary to parent 
window and Selected trace options, the trend summary report becomes dynamic. The associated channel and time frame of 
the summary list are updated as you interact with the parent frame graph. Placing a check next to Lock frame data results in 
the exception report becoming static. The dynamic nature of the report is disabled when the Lock frame data option is checked.
 
2.18.1.2 Parameters Tab
The actual parameters displayed are selected on the dialog’s second properties tab. This tab of the dialog box contains a list of 
available parameters and a list of selected parameters. The entries in the Selected parameters list are the items displayed on 
each line of the list. A parameter is added to the Selected parameters list by highlighting the desired parameter in the Available 
parameter list and pressing the Add>> button. Parameters are removed from the Selected parameter list by selecting the desired 
entry and pressing the <<Remove button.
 
Parameters can be moved up or down in the Selected parameters list by selecting the desired entry and pressing the Promote or 
Demote buttons. Parameters higher in the list are displayed before entries lower in the list. Promoting an entry moves it closer to 
the start of the displayed line. Demoting and entry moves it closer to the end of the displayed line.
 
The width of each column (parameter entry) can be automatically adjusted or you can specify a fixed width. To have the width of all 
columns automatically adjusted, place a check next to the Auto Width option. If you want to specify a fixed column width, remove 
the check from the Auto Width option, then select the parameter and specify a width in the Field Width edit box. The Field Width 
edit box sets the width for the selected parameter. You must select each parameter in turn to set its associated column width.
 
Selecting a parameter and then specifying the desired alignment can specify the horizontal alignment of each parameter. Each 
parameter has its own associated alignment. You must select each parameter in turn to change their associated column alignment.
 
A box can be drawn around the resulting list table by placing a check next to the Draw box around frame option. Removing the 
check from this option prevents the box for being drawn.
 
A grid can be drawn between each column and row of the table by placing a check next to the Draw grid option. Removing the 
check from this option prevents the grid from being drawn.
 
You can disable the relative highlighting of a parent graph by placing a check next to the Disable relative highlight of parent 
frame option.  When not checked, the parent graph will highlight the region of the graph corresponding to the start time and dura-
tion of the selected list entry.
 
You can also change the font used to display this text by clicking on the Font button and specifying the font attributes.
 
The Make Default button allows you to save the currently selected parameter list for future recall. Selecting the Make Default 
button saves the currently selected parameters, tab positions and text font into the Windows registry.
 
The Load Default button allows you to recall a previously saved parameter list, tab positions and text font.
 
Only a single default configuration can be saved at one time. Selecting the Make Default button over writes the previous default 
configuration.

2.19. CHANNEL LIST FRAME
The Channel List frame can be used independently or as a child frame linked to a Channel Graph frame. The Channel List frame 
displays a textual list of records for a specified list of channels.
 
When used independently, you specify the database to be loaded. When created independently, you can link other frames to it 
just as if it were a Graph frame.
 
Enabling Zoom parent frame on selection will cause the parent graph to zoom to the time period associated with the newly 
selected channel record entry.
 
Enabling Force display of trace will cause the trace for the selected channel record to be enabled for display in the parent frame 
even if it was not already. This has the effect of forcing the display of a channel record even if previously disabled.
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2.19.1. CHANNEL LIST PROPERTIES DIALOG BOX

The Channel List Properties dialog box allows you to specify what data is displayed in its associated list frame. This dialog box 
consists of three tabs: Channel List, Parameters, and Template.
 
2.19.1.1 Channel List Tab

This tab specifies the summary options available for the Channel List report frame. At the top of the tab, Database File name 
identifies the name of the database containing the recorded channel data. Below the database file name are five check boxes:

 � Display only those channels that are being displayed in parent frame. When this check box is selected, the Channel 
List frame will only include channels that are displayed in the Channel List’s parent frame. This allows users to (for exam-
ple) more easily correlate the listed channels with their graphs. When this option is not selected, all channels that have 
been previously added to the Channel List will be included, irrespective of whether or not they are also displayed in the 
parent frame.

 � Force display of trace: When selected, this option enables the selected channel record for display in the parent frame, 
even if it has been previously disabled. When this checkbox is selected, the Display only selected trace in parent frame 
check box is activated. When checked, this option instructs DataView to only display the selected test; all other entries are 
removed from the graph. When Display only selected trace in parent frame is unchecked, the selected channel is added 
and those already in the graph remain. This means that each time you select a test it will be added to the graph along 
with the previously selected channels; this could result in test results being displayed over other test results on the graph.

 � Zoom parent frame on selection: When checked, the parent graph is automatically zoomed to the time period associ-
ated with the newly selected entry.

 � List each channel once regardless of the number of records associated with it: When checked, each channel will 
appear in the Channel List only once. A channel can have multiple records associated with it, depending on its configura-
tion. For example, a continuous recording with no breaks in the data will typically occupy a single record, while a channel 
with breaks in the data (such as a logger configured to record only in alarm conditions) will likely require multiple records. 
Selecting the List each channel once regardless of the number of records associated with it check box results in  channels 
being listed only once; when this option is unchecked the Channel List will display all records associated with each channel.

Below these check boxes are fields for selecting channels. All available channels contained in the parent graph’s database are listed 
in the window on the left. Select the channel(s) to be used in the channel list report frame. One or more channels can be selected. 
To select more than one entry, press and hold down the CTRL key while right-clicking a list entry. Click Select All to include all 
available channels in the Channel List frame; Deselect All deselects all previously selected channels.

Selecting Enable scrolling instructs the frame to only display a specified number of lines. When this option is checked, the Window 
size field is activated to enable you to enter the number of entries to be displayed at a time. When scrolling is enabled, a scroll bar 
is displayed along the right side of the frame to move through the list. 
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2.19.1.2 Parameters Tab
 

This tab enables you to select which parameters will be listed in the Channel List frame, and how they are formatted and displayed. 
Entries in Selected parameters are the items displayed on each line of the list. You can add a parameter by highlighting it in the 
Available parameters list and clicking Add. You can remove a parameter from Selected parameters by highlighting it and clicking 
Remove. You can also add spaces between the parameters when they are displayed by clicking the Add Space button. 

Below the Available parameters list are two buttons labeled General and Specific. The General button displays available param-
eters that are common to all channels in the list. The Specific button displays parameters that apply only to specific channels.

Below these buttons are three check boxes:

 � Draw box around frame when checked results in a box being drawn around the Channel List table.
 � Draw grid specifies that you want a grid to be drawn between each column and row of the table.
 � Grow frame with text causes the Channel List frame to automatically resize appropriately depending on how much text 

it contains.  

Below the Selected parameters list are the four Line buttons. These buttons specify the line on which the selected parameters will 
appear. For example, click the button labeled 1 and select parameters to appear on the first line. When you are finished, you can 
click the button labeled 2 to add parameters to the second line, and so on through the fourth line.

The width of each column (parameter entry) can be automatically adjusted, or you can specify a fixed width. To have the width of 
all columns automatically adjusted, select the Auto Width check box. To specify a fixed column width, uncheck Auto Width.  This 
enables the Field width field; use this field to enter the width for the selected parameter. You must select each parameter in turn 
to set its column width. 

The Alignment radio buttons define the horizontal alignment (left, right, or center) for the selected parameter. You must select 
each parameter in turn to change its associated column alignment. 

You can assign the selected parameter a name to appear at the top of the column in the Channel List table. To do this, highlight 
the parameter and enter text into the Column Heading field. This text will appear in place of the parameter name in the appropri-
ate column in the Channel List table.

Parameters can be moved up or down in the Selected parameters list by selecting the desired entry and pressing the Promote 
and/or Demote buttons. Parameters higher in the list are displayed before entries lower in the list. Promoting an entry moves it 
closer to the start of the displayed line. Demoting an entry moves it closer to the end of the displayed line. 

The Make Sort Key button designates the selected parameter as the value by which the entries in the Channel List will be sorted. 
An asterisk (*) appears next to the parameter that has been defined as the sort key.

You can also change the font used to display text in the table by clicking on the Font button and specifying the font attributes. 
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The Load Default button allows you to recall a previously saved parameter list, tab positions, and text font. And the Make Default 
button allows you to save the currently selected parameter list for future recall. Selecting the Make Default button saves the cur-
rently selected parameters, tab positions, and text font into the Windows registry. Only a single default configuration can be saved 
at one time. Make Default overwrites the previous default configuration.

2.19.1.3 Template Tab
This tab provides settings that apply if the report that contains this Channel List will be used as a DataView report template. This 
tab includes three check boxes and a set of radio buttons. The check boxes, which appear at the top of the tab, are as follows:

 � Delete worksheet this list is on when opening as a template and the list is empty allows empty worksheets to be 
deleted automatically when creating a report from the template.  For example, if you add a tab that contains a channel 
list for a specific channel type, you can have the worksheet deleted automatically if a database that does not contain this 
channel type is opened using this template.  The worksheet becomes optional and is only added to the report if the list 
is not empty.

 � Display only the first list entry meeting the specified Template Filter instructs DataView to only include the first chan-
nel in the Channel List that meets the Template Filter setting (see below).

 � Duplicate worksheet for each list entry meeting the specified Template Filter results in a separate worksheet 
being created for each channel that meets the Template Filter criteria.

 
Below these check boxes are the Template Filter radio buttons. This setting only applies if the report that contains this Channel 
List is saved as a template. Template Filter allows you to specify which channels should be included when the template is used to 
display channels stored in a database. Template Filter options widen or narrow the list of channels that will be included.  You can 
create a template that only displays the exact channels you want by specifying the proper filter option.

 � All results in all listed channels being displayed by the template, without filtering.

 � Type Only: When selected, any channel of the same type (for example voltage waveforms) as those currently selected 
for display will be automatically included for display regardless of the channels code and modifier. 

DataView supports the following channel types:
  Voltage trend   PowerPad Power      Event Trend
  Voltage waveform   PowerPad Trend     ICT Measurement
  Current trend   PowerPad Waveform  DTR Result
  Current Waveform  PowerPad Transient  Monitoring Result
  Low Resolution Surge  Infomation   Aggregation Data Type
  Exceedence
  Low Resolution Sag  Bar Chart   Event List Type
  Exceedence
  High Resolution Surge  Bitmap    Trend
  Exceedence
  High Resolution Sag  Ground Tester Result  Session Total
  Exceedence
  Megohm Resistance Trend  XY Trace   PowerPad Inrush
  Megohm Voltage Trend  Micro Ohmmeter Result  PowerPad  Harmonic Trend
  Event Type   Event Type 2   XY Point Plot

 � Type and Code: When selected, any channel of the same type and with the same measurement code will be automatically 
included for display regardless of the channels modifier.  A channel code indicates the actual measurement.  For exam-
ple, Volts RMS and Volts THD each have the same channel type (Voltage trend) but have different measurement codes.

 � Type, Code and Modifier: When selected, only channels with the same data type, same measurement code, and same 
measurement modifier will be automatically included for display.  For example, Volts RMS Min, Volts RMS Max, and Volts 
RMS all have the same channel type and channel code.  However they each have a different channel modifier (Min, Max, 
and Avg). 

As an example, assume you have the following channels in a database:
  Volts RMS Min   Volts THD   Current THD Min
  Volts RMS max   Voltage Waveform  Current THD Max
  Volts RMS   Current RMS Min   Current THD
  Volts THD Min   Current RMS Max  Current Waveform
  Volts THD Max   Current RMS 
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You create a graph frame that contains the channels Volts RMS Min only, and select the Template Filter option Type Only. Save this 
report as a template. Next, when you open the sample database with this template, you will have the following channels selected 
for display automatically:
  Volts RMS Min  Volts THD Min 
  Volts RMS Max  Volts THD Max 
  Volts RMS  Volts THD 

The reason for this is that all these channels share the same channel type (Voltage trend). If you instead specify Type and Code 
for the Template Filter, the following channels are selected for display automatically:
  Volts RMS Min
  Volts RMS Max
  Volts RMS

These channels all have the same type and code; the only difference is the modifier (Min, Max, or Avg). Finally, if you select the 
Channel Type option Type, Code and Modifier; only the Volts RMS Min channel will be displayed.

2.20. CHANNEL SUMMARY FRAME
The Channel Summary frame is a child frame linked to a Channel Graph frame. The Channel Information frame has replaced the 
Channel Summary frame. The Channel Summary frame is available for older templates and views that use it.
 
The Channel Summary frame displays a textual summary of the channel record trace selected in its parent frame. You can custom-
ize the text displayed using the Channel Summary Properties dialog box. The displayed text is obtained from the trace selected 
in the parent frame.
 
The Channel Summary frame contains static and dynamic text. Static text is displayed as it was typed into the Channel Summary 
Properties dialog box. Dynamic text is generated through field substitution. The value obtained from the parent frame of the speci-
fied field is substituted for the field name.
 
Surrounding the exceedence statistics field name with square brackets, specifies dynamic text. For example, if the Exceedence 
Type field of the selected exceedence trace is Sag, placing the text [Exceedence Type] in the Exceedence Statistics Text edit box 
will result in Sag being displayed in its place on the worksheet.
 
Dynamic text substitution is useful for templates that create a report when recorded data is attached to it. The field name will reflect 
the name contained in the attached database, which may be different from database to database.

2.20.1. CHANNEL SUMMARY PROPERTIES DIALOG BOX

The Channel Summary Properties dialog box allows you to specify what type of channel record and what is displayed in its as-
sociated Channel Summary frame. The first tab of the Channel Summary Properties dialog box is illustrated in the following figure:



59

This tab of the dialog box contains a set of radio buttons that allow you to define what type of channel records this frame should 
display a summary for.
 
The text to be displayed is specified in the second tab of this dialog box. This tab is illustrated in the following figure:

This tab of the dialog box contains an edit box into which you type the static and dynamic text to be displayed in the Channel 
Summary frame. It also contains a list box from which you can select field names, field values and field codes.
 
Static text is displayed as it is typed into the Text edit box. Dynamic text is generated through field substitution. The value of the 
specified field as obtained from the Channel Summary frame’s parent is substituted for the field name.
 
Surrounding the field name with square brackets, specifies dynamic text. For example, if the DAR field of the selected megohm-
meter test measurement trace is 1.000, placing the text [DAR] in the Channel Summary Text edit box will result in 1.000 being 
displayed in its place on the worksheet.
 
Dynamic text substitution is useful for templates, which create a report when session data is attached to it. The field name will 
reflect the name contained in the attached database, which may be different from database to database.
 
Channel Summary fields can be added to the Text edit box in a number of ways. First, place the cursor in the Text edit box were 
the Channel Summary field is to be inserted. Next, click on the Channel Summary field (in the list box) to be inserted. The next step 
depends on what you want inserted. To insert the field name as static text, click on the Insert Field Name button (notice brackets 
are not placed around the field name). To insert the field value as static text, click on the Insert Field Value button (notice that the 
value displayed in the list box is inserted). To insert the field value as dynamic text, click on the Insert Field Code button (notice 
that the name of the field surrounded by square brackets is inserted).
 
If the selected Field does not have a current value associated with it the Insert Field Value button will be grayed and unavailable.
 
As in any text editor, pressing the Enter key will create a new line. Pressing the Tab key will position the cursor to the next tab 
position. You can change the default tab positions by selecting the Tabs button. This will display the Tabs dialog box.
 
You can also change the font used to display this text by clicking on the Font button and specifying the font attributes.
 

2.21. CHANNEL INFORMATION FRAME
The Channel Information frame is a child frame linked to a Channel Graph frame. The Channel Information frame displays a tex-
tual summary of the channel record trace selected in its parent frame. You can customize the text displayed using the Channel 
Information Properties dialog box. The displayed text is obtained from the trace selected in the parent frame.
 
The Channel Information frame contains static and dynamic text. Static text is displayed as it was typed into the Channel Summary 
Properties dialog box. Dynamic text is generated through field substitution. The value obtained from the parent frame of the speci-
fied field is substituted for the field name.
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Surrounding the exceedence statistics field name with square brackets, specifies dynamic text. For example, if the Exceedence 
Type field of the selected exceedence trace is Sag, placing the text [Exceedence Type] in the Exceedence Statistics Text edit box 
will result in Sag being displayed in its place on the worksheet.
 
Dynamic text substitution is useful for templates that create a report when recorded data is attached to it. The field name will reflect 
the name contained in the attached database, which may be different from database to database.

2.21.1. CHANNEL INFORMATION PROPERTIES DIALOG BOX

The Channel Information Properties dialog box allows you to specify what type of channel record and what is displayed in its as-
sociated Channel Information frame. The Channel Information Properties dialog box is illustrated in the following figure:

This dialog box contains a list of channel measurement types. Each measurement type has its own substitution text. You first select 
the channel type, then specify the text to be display for this channel type in the Display text edit box.
 
The text to be displayed for the selected channel type is specified in the Display text for selected channel type edit box of this dialog 
box. Type the static and dynamic text to be displayed in the Channel Summary frame into this edit box.

Below this edit box is a list box from which you can select field names, field values and field codes.
 
Static text is displayed as it is typed into the edit box. Dynamic text is generated through field substitution. The value of the speci-
fied field as obtained from the Channel Information frame’s parent is substituted for the field name.
 
Surrounding the field name with square brackets, specifies dynamic text. For example, if the DAR field of the selected megohm-
meter test measurement trace is 1.000, placing the text [DAR] in the Channel Information Text edit box will result in 1.000 being 
displayed in its place on the worksheet.
 
Dynamic text substitution is useful for templates, which create a report when session data is attached to it. The field name will 
reflect the name contained in the attached database, which may be different from database to database.
 
Channel fields can be added to the Text edit box in a number of ways. First, place the cursor in the Text edit box where the Channel 
field is to be inserted. Next, click on the Channel field (in the list box) to be inserted. The next step depends on what you want 
inserted. To insert the field name as static text, click on the Insert Field Name button (notice brackets are not placed around the 
field name). To insert the field value as static text, click on the Insert Field Value button (notice that the value displayed in the list 
box is inserted). To insert the field value as dynamic text, click on the Insert Field Code button (notice that the name of the field 
surrounded by square brackets is inserted).
 
If the selected Field does not have a current value associated with it, the Insert Field Value button will be grayed and unavailable.
 
As in any text editor, pressing the Enter key will create a new line. Pressing the Tab key will position the cursor to the next tab 
position. You can change the default tab positions by selecting the Tabs button. This will display the Tabs dialog box.
 
You can also change the font used to display this text by clicking on the Font button and specifying the font attributes.
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2.22. HISTOGRAM FRAME
A Histogram frame displays a bar chart of selected channels. As with graph frames you can customize the channels that are dis-
played and the colors of those channels. The channels are automatically grouped when displayed. The Histogram frame allows 
the following frames to be linked to it:

 � Channel Information: displays information about the selected bar
 � Graph Legend: displays a legend for the bars being displayed.
 � Session Summary: display summary information about the recording session.

 
A bar can be selected by positioning the mouse pointer over the desired bar and clicking the left mouse button. If a Channel 
Information frame is linked, it will be updated to display information about the selected bar.

2.22.1. HISTOGRAM PROPERTIES DIALOG BOX

This dialog box consists of two tabs. The first (Channels) tab allows you to select the channels to be displayed in the trend graph 
frame.

2.22.1.1 Channels dialog tab
Select a channel to be displayed by highlighting it (left-clicking the mouse pointer on it) in the Available channels list, then click 
on the Add>> button. The selected channel will be added to the Selected channels list. You can remove channels from the se-
lected channel list by highlighting it and clicking on the <<Remove button. You can add all of the available channels to the selected 
channels list by clicking on the Add All>> button. You can also remove all channels from the selected channel list by clicking on 
the <<Remove All button.

You can change the color used to draw each of the channels by highlighting its entry in the selected channel list and selecting 
an alternate color from the Line color drop-down list. You can also specify a color, other than one in the color list, by specifying 
the amount of each color component in the Red, Green and Blue fields. In addition, you can use the color picker to select from a 
wider range of colors.

The color picker dialog box is displayed by clicking on the color palette icon .

2.22.1.2 Scales dialog tab
The second (Scales) tab of this dialog box allows you to specify how the vertical scales of the associated graph are to be drawn.
 
Placing a check next to Automatically adjust vertical scale maximum instructs DataView to automatically adjust the upper end 
of the vertical scale to accommodate the displayed channels. Removing the check from this option causes the upper limit of the 
vertical scale to be fixed at the specified value.
 
Placing a check next to Enable lower limit for vertical scale maximum allows you to specify a value for which the upper end of 
the vertical scale is not allowed to go below.
 
Placing a check next to Automatically adjust vertical scale minimum instructs DataView to automatically adjust the lower end 
of the vertical scale to accommodate the displayed channels. Removing the check from this option causes the lower limit of the 
vertical scale to be fixed at the specified value.
 
Placing a check next to Display channel units on graph causes the units for each channel selected for display to be displayed on 
the left side of the graph. When this option is selected you can also over-ride the default channel units and display other text as units.
 
When Display channel units on graph is selected you can check Display channel units as. Doing so allows you to enter any text 
you would like displayed for the vertical scale units in the edit box to the right.

Placing a check next to Automatically adjust Start Date/Time instructs DataView to automatically adjust the starting time in the 
graph for displayed data to the earliest sample point in the data to be displayed. Removing the check allows you to over-ride this 
function and manually specify a starting date and time. It is this date and time that is used when the Zoom All function is selected.

Placing a check next to Automatically adjust Stop Date/Time instructs DataView to automatically adjust the ending time in the 
graph for displayed data to the latest sample point in the data to be displayed. Removing the check allows you to over-ride this 
function and manually specify an ending date and time. It is this date and time that is used when the Zoom All function is selected.

Placing a check next to Display upper threshold limit bar allows you to draw a horizontal line at the specified limit level and color.  
The limit bar is drawn for reference only and is not used to analyze the selected channels.
 
Placing a check next to Display lower threshold limit bar allows you to draw a horizontal line at the specified limit level and color.  
The limit bar is drawn for reference only and is not used to analyze the selected channels.

You can also change the font used to display text in the graph by clicking on the Font button and specifying the font attributes.
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2.22.1.3 Template dialog tab
 The third (Template) tab of this dialog box allows you to specify how the graph should be treated when it is being opened as part 
of a template.

Use template defined colors: this option allows you to over-ride the channel colors defined in a database with the colors speci-
fied in the Channel dialog tab. This option will only work for channels that are listed in the Selected Channels list. Channels not 
present in that list will use the default color specified in the database. If this option is not selected the channels will default to the 
colors in the database regardless of the colors selected in the Channel dialog tab.

Delete frame if selected channel list is empty when opening via a template: this option allows you to mark the frame (and 
all of the attached child frames) for deletion if the Selected channels list is empty after opening via a database when used as a 
template. Placing a check next to this option marks the frame for deletion, if empty. When not checked, the frame will not be deleted 
even if the database does not contain and similar channels (as defined by the Template Filter option).

Zoom all when opening via template: selecting this option will result in the graph displaying the entire range of samples auto-
matically when the database is opened  If this option is not selected the display range can be limited by other frames linked to the 
corresponding channel graph.

Template Filter: This option only applies when this report is saved as a template. It allows you to specify how channels should be 
included when used as a template to display channels stored in a database. The options available are:

 � Channel Type Only: when selected any channel of the same type (for example voltage waveforms) as those currently 
selected for display will be automatically included for display regardless of the channels code and modifier.

DataView supports the following Channel Types:
Voltage trend
Voltage waveform
Current trend
Standard resolution surge exceedence
Standard resolution sag exceedence
  High resolution surge exceedence
  High resolution sag exceedence
  Megohmmeter resistance trend
  Megohmmeter voltage trend
  PowerPad alarm
  PowerPad power
  PowerPad trend
  PowerPad waveform
  PowerPad transient
  Information (text record)
  Bar chart

 � Channel Type and Code: when selected, any channel of the same type and with the same measurement code will be 
automatically included for display regardless of the channels modifier. A channel code indicates the actual measurement.  
For example, Volts RSM and Volts THD each have the same channel type (Voltage trend) but have different measure-
ment codes.

 � Channel Type, Code and Modifier: when selected, only channels with the same data type, same measurement code 
and same measurement modifier will be automatically included for display. For example, Volts RMS Min, Volts RMS Max 
and Volts RMS all have the same channel type and channel code. However they each have a different channel modifier 
(Min, Max and Avg).

As an example let us assume that we have the following channels in a database:

Volts RMS Min
Volts RMS max
Volts RMS
Volts THD Min
Volts THD Max
Volts THD
Voltage Waveform
Current RMS Min
Current RMS Max
Current RMS
Current THD Min
Current THD Max
Current THD
Current Waveform
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We create a graph frame that contains the channels Volts RMS Min only and select the Template Filter option Channel Type Only.  
Then save this report as a template. Next, if we open the sample database with this template we will have the following channels 
selected for display automatically:

Volts RMS Min
Volts RMS Max
Volts RMS
Volts THD Min
Volts THD Max
Volts THD

The reason for this is that all these channels share the same channel type (Voltage trend). If we had specified Channel Type and 
Code for the Template Filter, the following channels would have been selected for display automatically.

Volts RMS Min
Volts RMS Max
Volts RMS

The reason for this is that these channels all have the same type and code. The only difference being the modifier (min, max or 
avg). Finally, if we had selected the Channel Type, Code and Modifier template filter option, only Volts RMS Min channel would 
have been displayed.

Using the Template Filter option, you can widen or narrow the list of channels that will be included. You can create a template that 
only displays minimum channels by specifying the proper filter option.

Once the desired properties for this new Graph frame are specified, select the OK button. The frame will be created using the 
specified properties

2.23. BAR CHART METER
A Bar Chart Meter frame displays individual sample points for a selected point in time on a graph in bar chart format. A bar for 
each channel is displayed with the bar for the corresponding channel representing the value of the sample point for the selected 
time point of the parent frame. The Bar Chart Meter frame is similar to the Meter Frame (that displays textual values) the Bar Chart 
Meter displays sample values in a bar representation.
 
As with graph frames, you can customize the channels that are displayed and the colors of those channels. The channels are 
automatically grouped when displayed. The Bar Chart Meter frame allows the following frames to be linked to it:

 � Channel Information: displays information about the selected bar.
 � Graph Legend: displays a legend for the bars being displayed.
 � Session Summary: display summary information about the recording session.

 
A bar can be selected by positioning the mouse pointer over the desired bar and clicking the left mouse button. If a Channel 
Information frame is linked, it will be updated to display information about the selected bar.

2.23.1. BAR CHART METER PROPERTIES DIALOG BOX

This dialog box consists of two tabs. The first (Channels) tab allows you to select the channels to be displayed in the trend graph 
frame.

2.23.1.1 Channels dialog tab
Select a channel to be displayed by highlighting it (left-clicking the mouse pointer on it) in the Available channels list, then click 
on the Add>> button. The selected channel will be added to the Selected channels list. You can remove channels from the se-
lected channel list by highlighting it and clicking on the <<Remove button. You can add all of the available channels to the selected 
channels list by clicking on the Add All>> button. You can also remove all channels from the selected channel list by clicking on 
the <<Remove All button.
 
You can change the color used to draw each of the channels by highlighting its entry in the selected channel list and selecting 
an alternate color from the Line color drop-down list. You can also specify a color, other than one in the color list, by specifying 
the amount of each color component in the Red, Green and Blue fields. In addition, you can use the color picker to select from a 
wider range of colors.
 
The color picker dialog box is displayed by clicking on the color palette icon .
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2.23.1.2 Scales dialog tab
The second (Scales) tab of this dialog box allows you to specify how the vertical scales of the associated graph are to be drawn.
 
Placing a check next to Automatically adjust vertical scale maximum instructs DataView to automatically adjust the upper end 
of the vertical scale to accommodate the displayed channels. Removing the check from this option causes the upper limit of the 
vertical scale to be fixed at the specified value.
 
Placing a check next to Enable lower limit for vertical scale maximum allows you to specify a value for which the upper end of 
the vertical scale is not allowed to go below.
 
Placing a check next to Automatically adjust vertical scale minimum instructs DataView to automatically adjust the lower end 
of the vertical scale to accommodate the displayed channels. Removing the check from this option causes the lower limit of the 
vertical scale to be fixed at the specified value.
 
Placing a check next to Display upper threshold limit bar allows you to draw a horizontal line at the specified limit level and color.  
The limit bar is drawn for reference only and is not used to analyze the selected channels.
 
Placing a check next to Display lower threshold limit bar allows you to draw a horizontal line at the specified limit level and color.  
The limit bar is drawn for reference only and is not used to analyze the selected channels.

Placing a check next to Automatically adjust Start Date/Time instructs DataView to automatically adjust the starting time in the 
graph for displayed data to the earliest sample point in the data to be displayed. Removing the check allows you to over-ride this 
function and manually specify a starting date and time.  It is this date and time that is used when the Zoom All function is selected.

Placing a check next to Automatically adjust Stop Date/Time instructs DataView to automatically adjust the ending time in the 
graph for displayed data to the latest sample point in the data to be displayed. Removing the check allows you to over-ride this 
function and manually specify an ending date and time. It is this date and time that is used when the Zoom All function is selected.

You can also change the font used to display text in the graph by clicking on the Font button and specifying the font attributes.

2.23.1.3 Template dialog tab
The third (Template) tab of this dialog box allows you to specify how the graph should be treated when it is being opened as part 
of a template.

Use template defined colors: this option allows you to over-ride the channel colors defined in a database with the colors speci-
fied in the Channel dialog tab. This option will only work for channels that are listed in the Selected Channels list. Channels not 
present in that list will use the default color specified in the database. If this option is not selected the channels will default to the 
colors in the database regardless of the colors selected in the Channel dialog tab.

Delete frame if selected channel list is empty when opening via a template: this option allows you to mark the frame (and all 
of the attached child frames) for deletion if the Selected channels list is empty after opening via a database when used as a tem-
plate.  Placing a check next to this option marks the frame for deletion, if empty. When not checked, the frame will not be deleted 
even if the database does not contain and similar channels (as defined by the Template Filter option).

Zoom all when opening via template: selecting this option will result in the graph displaying the entire range of samples auto-
matically when the database is opened. If this option is not selected the display range can be limited by other frames linked to the 
corresponding channel graph.

Template Filter: This option only applies when this report is saved as a template. It allows you to specify how channels should be 
included when used as a template to display channels stored in a database. The options available are:

 � Channel Type Only: when selected any channel of the same type (for example voltage waveforms) as those currently 
selected for display will be automatically included for display regardless of the channels code and modifier.
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DataView supports the following Channel Types:
Voltage trend
Voltage waveform
Current trend
  Standard resolution surge exceedence
  Standard resolution sag exceedence
  High resolution surge exceedence
  High resolution sag exceedence
  Megohmmeter resistance trend
  Megohmmeter voltage trend
  PowerPad alarm
  PowerPad power
  PowerPad trend
  PowerPad waveform
  PowerPad transient
  Information (text record)
  Bar chart

 � Channel Type and Code: when selected, any channel of the same type and with the same measurement code will be 
automatically included for display regardless of the channels modifier. A channel code indicates the actual measurement.  
For example, Volts RSM and Volts THD each have the same channel type (Voltage trend) but have different measure-
ment codes.

 � Channel Type, Code and Modifier: when selected, only channels with the same data type, same measurement code 
and same measurement modifier will be automatically included for display. For example, Volts RMS Min, Volts RMS Max 
and Volts RMS all have the same channel type and channel code. However they each have a different channel modifier 
(Min, Max and Avg).

As an example let us assume that we have the following channels in a database:

Volts RMS Min
Volts RMS max
Volts RMS
Volts THD Min
Volts THD Max
Volts THD
Voltage Waveform
Current RMS Min
Current RMS Max
Current RMS
Current THD Min
Current THD Max
Current THD
Current Waveform

We create a graph frame that contains the channels Volts RMS Min only and select the Template Filter option Channel Type Only.  
Then save this report as a template. Next, if we open the sample database with this template we will have the following channels 
selected for display automatically:

Volts RMS Min
Volts RMS Max
Volts RMS
Volts THD Min
Volts THD Max
Volts THD

The reason for this is that all these channels share the same channel type (Voltage trend). If we had specified Channel Type and 
Code for the Template Filter, the following channels would have been selected for display automatically.

Volts RMS Min
Volts RMS Max
Volts RMS

The reason for this is that these channels all have the same type and code. The only difference being the modifier (min, max or 
avg). Finally, if we had selected the Channel Type, Code and Modifier template filter option, only Volts RMS Min channel would 
have been displayed.
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Using the Template Filter option, you can widen or narrow the list of channels that will be included. You can create a template that 
only displays minimum channels by specifying the proper filter option.

Once the desired properties for this new Graph frame are specified, select the OK button. The frame will be created using the 
specified properties

2.24. SESSION LIST FRAME
The Session List frame displays a textual list of session records for a specified database. The Session List Properties dialog box 
allows you to specify what is displayed in its associated list frame.

2.24.1. SESSION LIST TAB

The first tab of the Session List Properties dialog box is illustrated in the following figure.

This tab of the dialog box allows you to specify the summary options available for the Session List frame. The items in this dialog 
box are defined as follows:
 
Database: indicates the name of the database containing the recorded channel data. It is available for information only and is 
obtained from the parent trend graph.
 
Force display of trace: when selected, the traces for the selected session record will be enabled for display in the child frame(s) 
even if they were not already. This has the effect of forcing the display of channel records even if previously disabled.
 
Zoom child frame on selection: when checked, the child frame(s) are automatically zoomed to the time period associated with 
the newly selected entry. 
 
Scrolling

 � Enable scrolling: placing a check next to this option causes the frame to only display the specified number of lines. Scroll 
bars are displayed along the right side of the frame to move through the list.

 � Window size: specifies the maximum number of lines to be display in the frame for scrolling.
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2.24.2. PARAMETERS TAB

The actual parameters displayed are selected on the dialog box’s second properties tab. This tab is illustrated in the following figure.

 
This tab of the dialog box contains a list of available parameters and a list of selected parameters. The entries in the Selected 
parameter list are the items displayed on each line of the list. A parameter is added to the Selected parameters list by highlighting 
the desired parameter in the Available parameter list and pressing the Add>> button. Parameters are removed from the Selected 
parameter list by selecting the desired entry and pressing the <<Remove button.
 
Parameters can be moved up or down in the Selected parameters list by selecting the desired entry and pressing the Promote or 
Demote buttons. Parameters higher in the list are displayed before entries lower in the list. Promoting an entry moves it closer to 
the start of the displayed line. Demoting an entry moves it closer to the end of the displayed line.
 
The width of each column (parameter entry) can be automatically adjusted or you can specify a fixed width. To have the width of all 
columns automatically adjusted, place a check next to the Auto Width option. If you want to specify a fixed column width, remove 
the check from the Auto Width option, then select the parameter and specify a width in the Field Width edit box. The Field Width 
edit box sets the width for the selected parameter. You must select each parameter in turn to set its associated column width.
 
Selecting a parameter and then specifying the desired alignment can specify the horizontal alignment of each parameter. Each 
parameter has its own associated alignment. You must select each parameter in turn to change their associated column alignment.
 
A box can be drawn around the resulting list table by placing a check next to the Draw box around frame option. Removing the 
check from this option prevents the box for being drawn.
 
A grid can be drawn between each column and row of the table by placing a check next to the Draw grid option. Removing the 
check from this option prevents the grid from being drawn.
 
You can disable the relative highlighting of a parent graph by placing a check next to the Disable relative highlight of parent 
frame option. When not checked the parent graph will highlight the region of the graph corresponding to the start time and dura-
tion of the selected list entry.
 
You can also change the font used to display this text by clicking on the Font button and specifying the font attributes.
 
The Make Default button allows you to save the currently selected parameter list for future recall. Selecting the Make Default 
button saves the currently selected parameters, tab positions and text font into the Windows registry.
 
The Load Default button allows you to recall a previously saved parameter list, tab positions and text font.
 
Only a single default configuration can be saved at one time. Selecting the Make Default button over writes the previous default 
configuration.



68

2.25. TABLE OF CONTENTS FRAME
The Table of Contents frame displays a textual list of worksheets and their associated page numbers. The Table of Contents 
Properties dialog box allows you to specify what is displayed in its associated list frame.

2.25.1. PARAMETERS TAB

The actual parameters displayed are selected on the dialog box’s properties tab. This tab is illustrated in the following figure.

This tab of the dialog box contains a list of available parameters and a list of selected parameters. The entries in the Selected 
parameter list are the items displayed on each line of the list. A parameter is added to the Selected parameters list by highlighting 
the desired parameter in the Available parameter list and pressing the Add>> button. Parameters are removed from the Selected 
parameter list by selecting the desired entry and pressing the <<Remove button.
 
Parameters can be moved up or down in the Selected parameters list by selecting the desired entry and pressing the Promote or 
Demote buttons. Parameters higher in the list are displayed before entries lower in the list. Promoting an entry moves it closer to 
the start of the displayed line. Demoting an entry moves it closer to the end of the displayed line.
 
The width of each column (parameter entry) can be automatically adjusted or you can specify a fixed width. To have the width of all 
columns automatically adjusted, place a check next to the Auto Width option. If you want to specify a fixed column width, remove 
the check from the Auto Width option, then select the parameter and specify a width in the Field Width edit box. The Field Width 
edit box sets the width for the selected parameter. You must select each parameter in turn to set its associated column width.
 
Selecting a parameter and then specifying the desired alignment can specify the horizontal alignment of each parameter. Each 
parameter has its own associated alignment. You must select each parameter in turn to change their associated column alignment.
 
A box can be drawn around the resulting list table by placing a check next to the Draw box around frame option. Removing the 
check from this option prevents the box for being drawn.
 
A grid can be drawn between each column and row of the table by placing a check next to the Draw grid option. Removing the 
check from this option prevents the grid from being drawn.

You can also change the font used to display this text by clicking on the Font button and specifying the font attributes.

The Make Default button allows you to save the currently selected parameter list for future recall. Selecting the Make Default 
button saves the currently selected parameters, tab positions and text font into the Windows registry.

The Load Default button allows you to recall a previously saved parameter list, tab positions and text font.

Only a single default configuration can be saved at one time. Selecting the Make Default button over writes the previous default 
configuration.
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3. WORKING WITH FRAMES

Once a frame is created, it can be moved, resized, cut, copied and pasted on the worksheet. In addition, its associated properties 
can be modified.

To select a frame for modification, use the Select Frame  tool, then select the desired frame by placing the mouse pointer 
over it and clicking the left mouse button. Resize handles will be displayed around the selected frame. The following figure shows 
a Graph frame that has been selected.

The graph frame has been selected and has the resize handles displayed. The resize handles are located in each of the four corners 
and at the middle of each of the four sides. When the mouse pointer is over a resize handle, the pointer changes to a resize arrow 
indicating the direction that handle will resize the frame in. To resize the frame, click on and drag the resize handle in the required 
direction. Dragging the upper left handle leaves the lower right corner of the frame anchored and allows you to move the upper 
left corner of the frame. Each of the remaining corners allow you to move it leaving the corner diagonal to it fixed. Dragging one of 
the resize handles located in the middle of a side moves the corresponding side only, leaving the corners for the other side fixed.
 
Clicking and dragging in the center of the frame will move the frame (unless the frame is locked down). Notice the mouse pointer 
changes to four arrows when it is over the frame. When the mouse pointer is not over the selected frame, it is the default selection tool 
and does not allow the frame to be resized. In all cases, the displayed pointer indicates where and how the frame can be changed.
 
When a frame is placed within another frame you may not be able to select it. The following figure shows a text box within a graph 
frame.
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If the graph was placed on the worksheet before the text box, the graph will be selected instead of the text. This is because it is 
first in the View’s list of frames. When DataView searches the list of frames for a possible selection, it will find the graph first and 
stop. To resolve this, you must send the graph frame to the end of the list. This is done by selecting the graph with the Select Frame 

tool and clicking on the Send To Back  toolbar icon. This will move the selected frame to the end of the list. The next time 
you click on the text box, it will be found in the list before the graph frame and will be selected instead of the Graph frame.

Alternatively, you can bring a frame to the beginning of the list by selecting it and clicking on the Bring To Front  toolbar icon. 
This will bring the selected frame to the beginning of the frame list.

The properties of a frame can be modified at any time by right-clicking the mouse with the Select Frame tool over it. This will display 
a context sensitive menu giving options relevant to the type of frame the mouse pointer is over. All frames will have a Properties 
menu option. Selecting the Properties menu option will display the frame’s corresponding properties dialog box. Change the prop-
erties as desired and select the OK button.

3.1. CUTTING, COPYING, AND PASTING FRAMES
DataView® allows you to move (cut) and copy frames from a worksheet to a temporary holding place called the clipboard. You can 
then paste the frame and its contents to the same worksheet, another worksheet within the same report or another woksheet in 
another report. In addition to the Windows® clipboard, DataView® maintains its own application clipboard for cutting and pasting 
frames. The application clipboard is used to cut and paste frames within the DataView® application. When frames are cut, their 
contents are also copied to the Windows® clipboard. The Windows® clipboard is used for copying data between applications. Items 
copied to the Windows® clipboard can be pasted into other applications that support this function.
 
Use the Paste command to paste data in the application clipboard and the Paste Special command to paste from the Windows® 

Clipboard. The Paste Special command will paste the Windows® Clipboard data as an OLE frame. For more information on Paste 
Special see the Paste Special command.

3.1.1. CUTTING A FRAME

Frames can be removed from a worksheet at any time. To remove a frame and its contents from a worksheet, perform the follow-
ing steps:

1. Select the frame to be removed with the selection tool. The selected frame will display the resize handles.

2. Select the Cut command from the Edit menu or click on the Cut  toolbar icon. The frame will be removed from the tab. 

The Cut menu command and the Cut toolbar icon are enabled only while a frame is selected.
 
Note: A frame with attached child frames cannot be removed from the worksheet before all the attached child frames.
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3.1.2. COPYING A FRAME

Frames can be copied into the application and Windows® clipboards. Like the Cut Frame command, the content of a frame is copied 
to the application and Windows® clipboard. Unlike the Cut command, the frame is not removed from the worksheet, only copied to 
the clipboards. To copy a frame to the application and Windows® clipboards, perform the following steps:

1. Select the frame to be copied with the selection tool. The selected frame will display the resize handles.

2. Select the Copy command from the Edit menu or click on the Copy  toolbar icon. The frame and its contents will
 be copied to the application clipboard. The contents of the frame will also be copied to the Windows® clipboard. The frame
 will not be removed from the worksheet. 

The Copy menu command and the Copy toolbar icon are enabled only while a frame is selected.

3.1.3. PASTING A FRAME

Frames previously cut or copied to the application clipboard can be pasted onto the same worksheet they were copied (or cut) 
from. They can also be pasted onto another worksheet within the same report or a tab within another report. To paste a frame onto 
a worksheet, perform the following steps:

1. Scroll to the worksheet that the frame is to be pasted on.

2. Select the Paste command from the Edit menu or click on the Paste  toolbar icon. The frame and its contents 
 currently in the application clipboard will be placed on the currently displayed worksheet.

The worksheet the frame will be pasted onto is the current worksheet. The current worksheet is indicated in the worksheet number 
pane on the status bar. For example, if the current worksheet is number one of a two-worksheet report, the worksheet number 
status pane will contain Sheet 1 of 2.
 
The Paste command and the Paste toolbar icon are enabled only when a frame is in the application clipboard.
 

3.2. MOVING A FRAME TO ANOTHER WORKSHEET
When dragging a frame around in a report, you can only move it to another location on the same worksheet. You cannot drag it from 
one worksheet to another. To move frames from one worksheet to another, use the application clipboard as a temporary holding 
place. To move a frame from one worksheet to another, perform the following steps:

1. Select the frame to be removed with the selection tool. The selected frame will display the resize handles.

2. Select the Cut command from the Edit menu or click on the Cut  toolbar icon. The frame will be removed from the 
 worksheet.

3. Scroll to the worksheet the frame is to be pasted on, making sure that only the desired worksheet is displayed. If part 
 of the preceding worksheet is displayed when the mouse is moved up to the toolbar or menu bar, the current worksheet will 
 change to that worksheet as the mouse pointer passes over it. When the frame is pasted, it is pasted to the current 
 worksheet.

4. Select the Paste command from the Edit menu or click on the Paste  toolbar icon. The frame will be pasted onto 
 the current worksheet.

Once the frame is pasted onto the desired worksheet, you can move it to anywhere on that worksheet.

3.3. COPYING A FRAME TO ANOTHER WORKSHEET
When copying a frame within DataView®, it is copied to the current worksheet. To copy a frame from one worksheet to another, 
copy the frame from the worksheet it is on, then scroll to the desired worksheet and paste it. To copy a frame from one worksheet 
to another, perform the following steps:

1. Select the frame to be removed with the selection tool. The selected frame will display the resize handles.

2. Select the Copy command from the Edit menu or click on the Copy  toolbar icon. The frame will be copied to the 
 application and Windows® clipboard.
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3. Scroll to the worksheet the frame is to be pasted on. Make sure that only the desired worksheet is displayed. If part of the 
 preceding worksheet is displayed when the mouse is moved up to the toolbar or menu bar, the current worksheet will 
 change to that worksheet as the mouse pointer passes over it. When the frame is pasted, it is pasted to the current 
 worksheet.

4. Select the Paste command from the Edit menu or click on the Paste  toolbar icon. The frame will be pasted onto 
 the current worksheet.

Once the frame is pasted onto the desired worksheet, you can move it to anywhere on that worksheet.

3.4. LOCKING A FRAME IN PLACE
When a frame is placed on a report, you are free to move it around and change its size. This also allows you to accidentally move 
or change its size. You can prevent this from occurring by locking the frame’s position and size. This is accomplished using the 
Lock Frame command. This command is accessible via the Frame menu and the pop-up menu. The pop-up menu is displayed 
by clicking the right mouse button, while the mouse cursor is over the desired frame.
 
When a frame is locked, it will remain at a fixed location and size. Once a frame is locked, it will remain locked until it is unlocked 
via the Unlock Frame command.
 
The Lock Frame command is only available when a frame is selected and the selected frame is unlocked. Once the selected frame 
is locked, the Lock Frame command will be grayed and the Unlock Frame command will be enabled. Also, while a frame is locked, 
the cursor does not change to the frame resize or move cursor.

3.4.1. UNLOCKING A LOCKED FRAME

When a frame is placed on a report and locked in place (via the Lock Frame command), you can not move it around or change its 
size. This prevents you from accidentally moving or changing its size once placed at the location you want it to stay. If you later 
want to move or resize the frame, it must be unlocked first. This is accomplished using the Unlock Frame command. This com-
mand is accessible via the Frame menu and the pop-up menu. The pop-up menu is displayed by clicking the right mouse button 
while the mouse cursor is over the desired frame.
 
While a frame is unlocked, it can be moved or resized. Once a frame is unlocked, it will remain unlocked until it is locked via the 
Lock Frame command.
 
This command is only available when a frame is selected and the selected frame is locked in place. Once the selected frame is 
unlocked, the Unlock Frame command will be grayed and the Lock Frame command will be enabled.
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4. OLE

4.1. EDIT LINKS
When an OLE item is placed in the report, it can be copied into or linked to the original file. When copied into the report, changing 
the original file will have no effect on the object in the report. When linked to the file, it is not copied into the report and changes 
made to the original result in the embedded object changing, as well.
 
Use this command to display a Links dialog box that lets you edit links between your document and other documents.
 
This command is unavailable if you have no links in your document.

The Links dialog box displays the current links used in this document, their type, and update status. If the source file for the link 
cannot be found, the update column will read Unavailable. This typically happens if the source file is on an unavailable network 
drive, or if the source file has been moved.
 
When an entry in the Links list is selected, the Source and Type fields will be updated to reflect the selected link. In addition, the 
Update radio button, Update Now, Open Source, Change Source and Break Link buttons will become active for the selected link.
 
The Update field specifies whether you want the selected link to be updated automatically or manually. If you select Automatic, 
whenever you change the linked information in the original document, the frame in the report will be updated automatically. If you 
select Manual, you need to click on the Update Now button when you want the frame to be updated. To change the update status 
of a link, click the link, and then Automatic or Manual.

 � Cancel closes the Links dialog box before any changes are made. Once a link is modified, the Cancel button is replaced 
with the Close button. This indicates that changes have been made and applied to the selected link(s).

 � Update Now updates the corresponding frame with the selected link.

 � Open Source opens the source file for the selected link.

 � Change Source changes the source file for the selected link.

 � Break Link removes the connection between the selected link and the source file. When the link to the external file is bro-
ken, the frame becomes a static object and can no longer be edited. It will be fixed at the state when the link was broken.

4.2. OBJECT VERB
The Object option in the Edit menu will change to reflect the type of OLE frame selected. For example, when selecting a bitmap 
linked object, it will be replaced with the text Linked Bitmap Image Object. This new entry can have up to three submenu com-
mands: Edit, Open and Convert.
 
The Edit option will open the object for editing. If it is a linked object, then the application will be started and the corresponding link 
file loaded into it. If the object was copied into the report (not linked), then it will be opened for in-place editing.
 
Selecting Open will start the corresponding application to edit the object regardless of whether it is a link or copy.
 
Selecting Convert will display the Convert dialog box. This dialog box lists the types of format conversions available, and allows 
you to perform the conversion.

4.3. INSERT OBJECT
The Insert Object command inserts a new frame into onto the current worksheet in the current report. The Frame Type dialog box 
will be displayed, allowing you to specify the type of frame to create. Select the type of frame you want to insert into your docu-
ment using the Frame Type dialog box.

4.3.1. INSERT NEW OBJECT DIALOG BOX

This dialog box allows you to specify the object and how it is to be attached to the report. Click on Create New to create a new 
object to be insert into the report. The new object will be of the type you specify. Click on Create from File to insert an entire file 
into the report. The file will be inserted as an object that can be edited with the application that created it.
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 � Create New: When creating new objects, select the Create New radio button. The Object Type list will be displayed. 
From this list, select the type of application specific object that is to be created. Use the scroll bar to view additional types. 
The Display As Icon check box specifies whether the embedded object will appear in the report as an icon or the actual 
contents of the object will be visible. While the Display As Icon item is checked, a Change Icon button will be available. 
Click this button to specify the icon to be displayed for the object. Once these items are specified, select the OK button. 
The OLE frame will be created and the corresponding application started for in place editing (if supported).

 � Create from File: When creating a new object, select the Create from File radio button. The File entry field will be 
displayed, which provides a space to type the name of the file you want to insert into the report. You can also use the 
Browse button to locate the file. Next, specify how the object is to be inserted into the report (Linked or Copied). This is 
done by placing (or not placing) a check beside the Link option. Checking the Link option will cause a link to the original 
file to be maintained. If this option is not checked, then the object will be embedded (copied) into the report. If the file is 
linked, changes made to the object in the report will appear in the original file, and changes made to the original file (via 
its corresponding application) will appear in the report. Once the options are specified, select the OK button. The object 
will be added to the report in the specified manner.

4.3.2. CHANGE ICON DIALOG BOX

This dialog box allows you to specify the icon and its type to be displayed for the embedded object.

 � Current displays the icon that will appear in the current document.

 � Default specifies that the icon representing the embedded or linked information in your document is the default icon for 
the program that was used to create it.

 � From File specifies that the icon is from a file. A list of icons from the specified file will be displayed under the From File 
edit box. Select the icon to be used from the displayed list. If no icons are shown, then the specified file does not contain 
any or it cannot be found.

Use the Browse button to search for a file containing icons.

The Label field provides a space for you to type a label for the icon as it will appear in your document. A default label is used un-
less you change it.

4.3.3. CONVERT DIALOG BOX

The Convert dialog box allows you to convert the selected OLE frame from its current format to another format. The available 
types to convert to will depend on the type of OLE object the frame contains. The following is a list of each item in this dialog box 
and a description of its function:

 � Current Type lists the available file types that you can use to open the embedded or linked information.

 � Convert to specifies that the object is to be converted to a different type. This is useful if you no longer have the program 
that was used to create the object, or if you want to display the object in a different format than the original type allows.

 � Activate as specifies that the object is to be opened using a different program that is compatible with the original object type.

 � Object Type lists the available file types that you can use to open the embedded or linked object.

 � Results describes the operation that will be performed for the currently selected options. Notice, the text displayed, changes 
as options are changed. The displayed text describes whether the object will be converted to a different file type, what that 
file type will be, and how the object will appear in the frame. This is useful for experimenting with different conversions 
without actually implementing them. To implement the conversion, click the OK button.

 � Display As Icon specifies whether the embedded object will appear in the report as an icon, or the actual contents of the 
object will be displayed. If you select Display As Icon, you can open the object in the report by double-clicking its icon. 
When this option is checked, the Change Icon button is displayed, allowing you to select an alternate icon. Clicking on 
the Change Icon button will display the Change icon dialog box.

 � OK button closes the dialog box and saves changes you have made.

 � Cancel button closes the dialog box without saving any changes you have made.
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4.3.4. PASTE SPECIAL DIALOG BOX

This allows you to paste the contents of the Windows® clipboard into the active report as an OLE frame. The following is a list of 
each item in this dialog box and a description of its function.

 � Source displays the name of the source data and its location. If you copied the data from an application that did not provide 
the source data and its location to the Clipboard, the source is identified as “Unknown.”

 � Paste / Paste Link: To insert or embed the Clipboard contents at the insertion point in the format specified in the As box, 
select the Paste radio button. When you select this option, the Clipboard contents are pasted or embedded, but no link is 
created. To create a link, select the Paste Link check box.

 � As: This is a selection list, which you use to specify the type of information you want to paste from the Clipboard. To specify 
the format, click the type in the As box.

 � Results displays what the results of the selected options will be.

 � Display as Icon: To display the Clipboard contents as an icon, select the Display As Icon check box. Use this option if you 
do not want data to be displayed in the report. When this option is checked, the Change Icon button is displayed, allowing 
you to select an alternate icon. Clicking on the Change Icon button will display the Change icon dialog box.

 � OK button closes the dialog box and saves changes you have made.

 � Cancel button closes the dialog box without saving any changes you have made.
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5. TEMPLATES

A template is a file that defines the type, placement and properties of frames in a report. Unlike a report, a template does not need 
to have a database attached to it. That is, any frames in the template that display the contents of a database, do not necessarily 
contain the name of a database. Alternatively, a report is a template that has the name(s) of the database(s) specified in it.
 
The main difference between a report and a template is the file name extension. When a report is opened, the specified databases 
are opened and loaded, as well. When a template is opened, the user is asked to specify the name(s) of the database file(s) needed, 
at which point the template is attached to the database and becomes a report.
 
DataView® comes with a set of templates, each for a specific type of instrument and configuration.
 
A template is attached to a database by any of the following methods:

 � Downloading instrument data.
 � Opening a template.
 � Opening a database.

5.1. CREATE REPORT FROM TEMPLATE DIALOG BOX
The Create Report from Template dialog box allows you to select, in one-place, template and database files to be joined to cre-
ate a report.
 
This dialog box contains the following options:

 � Template Name Field: Specifies the template to be used in the creation of a report. This field is specified via the Browse 
button or by selecting a template from the Templates List Box.

 � Template Browse Button: This button (located next to the Template Name field) allows you to select (via an Open File 
dialog box) a desired template file.

 � Template Groups List Box: Lists the groups (directories) found in the Templates directory.

 � Templates List Box: Lists the templates within the selected group.

 � Database List Box: Indicates the number of databases needed to fulfill the requirements of the specified template.

 � Database Browse Button: This button (located next to the Database list box) allows you to select (via an open file dialog) 
desired database files.

 
The process of creating a report is performed in the following steps:
 

1. Specify the template to use.
2. Specify database (or databases) to be viewed.
3. Select the OK button.

 
Each step must be completed in order. The template must be selected before a database can be selected. The database list must 
be completed before the OK button can be selected. The controls for each step are disabled until the preceding step is completed.
 
Depending on how this dialog box was invoked, the template or database entries may already be specified. For example, when 
invoked from the Quick Start dialog box by selecting the Create New Report from Template button, neither of the two steps 
are completed. When invoked by selecting a database to open or after downloading data from an instrument, Step 2: Specify 
Database will contain the name of the database previously specified. When invoked by selecting a template to open, Step 1: 
Specify Template will contain the name of the template previously specified.
 
A template is specified by either selecting one via the Browse button or selecting one from the Templates list. When using the 
Browse button, an Open File dialog box is displayed. Use this dialog box to locate and select a template not in one of the groups.  
To select a template from a group, first select the corresponding entry in the Groups list box.  The Templates list will be updated to 
reflect the templates within the selected group.  Then select a template from the Templates list box.
 
When a template is selected, it is scanned to identify the number of databases it requires. The number of databases is indicated 
in the Specify Database list box. For example, selecting a template that calls for two different databases, results with 1: and 2: 
entries appearing in the database list box.
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If the Create Report from Template dialog box was invoked by selecting a database to be opened, the Specify Database list will 
be initialized with 1: DatabaseName (where DatabaseName is the name of the previously selected database) as the first and 
only entry. Subsequent selection of a template will use this database name as the first, and add empty entries for any additionally 
required databases.
 

Once the template has been specified, the database can be selected using the Browse button located next to the Database list. If 
the database(s) have already been specified (either prior to invoking this dialog box or by selecting the Browse button) and none 
of these database entries are selected, the Browse database button is disabled.
 

A listed database entry can be changed by, first selecting the database entry, then selecting the Browse button. When specifying 
a database, the highlighted database entry is modified. If no database entry is selected and entries remain to be specified, select-
ing the Browse button sets the first unspecified database entry. If all database entries are specified and none of these entries are 
selected, the Browse database button is disabled. 

5.2. ATTACH TEMPLATE WHEN DOWNLOADING DATA
A template can be attached to a database at the time the database is created. The process of downloading, saving and viewing 
data from an instrument takes the following steps:
 

1. Select Download from the Instrument menu. The Connection dialog box is displayed.

2. Select the communications port and rate from the drop-down list boxes.

3. Select the OK dialog button. A connection with the instrument will be established and any data currently stored in it will 
 be downloaded.

4. Once the download is complete, the Save As dialog box will be displayed. Specify the name to save the database under.

5. Specify the Session Properties.

6. A dialog box will be displayed, indicating the success or failure of the data decode process. Assuming the data decode 
 was successful, select the OK button and continue. If an error was reported, resolve the error before proceeding.

7. Answer yes to the question, “Do you want to open database just downloaded?” The Create Report from Template dialog 
 box will be displayed.

8. Select the template to use for the initial display of the database. See Section 5.1 for more information about this dialog box.

9. Select the OK button in the Create Report from Template dialog box.

10. Customize each object frame as desired.
 
Once the Create Report from Template dialog box is closed and the transformation is specified, the resulting report will be dis-
played, at which point you can view and manipulate it as desired.

5.3. ATTACH DATABASE WHEN OPENING A TEMPLATE
When a template is opened, the user is asked to supply the name(s) of the database(s) needed to complete its display. When the 
database(s) are specified, they are attached to the template and it becomes a report.
 

1. The following steps illustrate the procedure of opening a template and creating a report:

2. Select Open from the File menu.

3. Select DataView® Template Files (*.dvt) from the Files of type: drop-down list.

4. Select or specify the name of the template file.

5. Select the Open button. The Create Report from Template dialog box will be displayed.

6. Specify the name of each database file needed to complete the transformation of the template to a report. See Create 
 Report from Template dialog box for more information.

7. Select the OK button in the Create Report from Template dialog box.

8. Customize each object frame as desired.

Once the Create Report from Template dialog box is closed and the transformation is specified, the resulting report will be dis-
played, at which point you can view and manipulate it as desired.
 



78

5.4. ATTACH TEMPLATE WHEN OPENING A DATABASE
When a database is opened, the user is asked to supply the name of the template to define its display. When the template is speci-
fied, it is attached to the database resulting in a report.
 

1. The following steps illustrate the procedure of opening a database and creating a report:

2. Select the Open option from the File menu.

3. Select DataView® Database Files (*.dvb) from the Files of type: drop-down list.

4. Select or specify the name of the database file.

5. Select the Open button. The Create Report from Template dialog box will be displayed.

6. Select the template to use for the initial display of the database. See Section 15.1 for more information.

7. Specify any additional databases (if any) required by the selected template.

8. Select the OK button in the Create Report from Template dialog box.

9. Customize each object frame as desired.

10. Once the Create Report from Template dialog box is closed and the transformation is specified, the resulting report will 
be displayed, at which point you can view and manipulate it as desired.

 

5.5. CREATING A TEMPLATE
A template is created when a report is saved with the database detached. The following steps illustrate the procedure of creating 
a new template: 

1. Open an existing report or create a new one.

2. Modify the report as desired.

3. Select the Save As Template option from the File menu.

4. Specify the name of the template in the File name: field.

5. Select the Save button.
 

5.6. MODIFYING A TEMPLATE
A template can only be modified when it is a report. Templates are not modified in their native format and only when the data to be 
displayed is attached. The following steps illustrate the procedure of modifying a template:

1. Select Open from the File menu.

2. Select DataView® Template Files (*.dvt) from the Files of type: drop-down list.

3. Select or specify the name of the template file.

4. Select the Open button. The Create Report from Template dialog will be displayed.

5. Specify the name of each database file needed to complete the transformation of the template to a report. See Create 
 Report from Template dialog box for more information about this dialog box.

6. Select the OK button in the Create Report from Template dialog box.

7. Customize each object frame, as desired.

8. Save the report as a template using the name specified in step 3. See Creating a Template for steps to complete this 
 process.

A new template, based on an existing template, can be created using the previous procedure, except specify a different name in 
step 7. The original template will be left as is and a new one with the specified name created.
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6. ZOOMING

Frames displaying graphs of trend and waveform measurement data allow for a number of display extent commands. These com-
mands allow you to indicate the starting and ending times of the displayed data. By changing the start and ending display times, 
you can zoom in, zoom out, pan left and right, pan to start and pan to end of measurement data. Each of these commands can 
be selected from the Zoom menu or from the toolbar. Each of these commands and their associated operation is discussed in the 
following sections. 

6.1. ZOOM TO SELECTION
When a graph frame is first created, the displayed channels are shown in the full time extents of the stored data. You can zoom in 
on a selected area using the Zoom Tool. To zoom to a selected area of a graph, perform the following steps:
 

1. Select the Zoom Tool command from the Zoom menu or click on the Zoom Tool  toolbar icon. This will enable the 
 zoom selection tool. The mouse pointer will change to this tool while it is over a graph that supports zooming. When the 
 mouse pointer is not over a frame or area of a frame that supports zooming, the mouse pointer becomes the default 
 selection tool.

2. Move the zoom selection tool to the location of the graph that will become the upper left corner of the displayed extents.

3. Click and hold the left mouse button.

4. Drag the mouse to the location on the graph where the lower right corner of the display extents is to be located. Notice 
 as you move the mouse pointer, a dotted box is displayed. This dotted box shows the area of the graph that will become 
 the displayed extents.

5. Release the mouse button. The graph will be redrawn to the new extents indicated by the zoom selection box.
 
This tool performs a “zoom to selected area” operation, hence the name Zoom Selection tool. This process can be repeated, as 
needed. 

6.2. ZOOM PREVIOUS
When zoom operations are performed, the display extents prior to zooming are saved. This allows you to undo any zoom opera-
tion and return to the previously displayed extents. To undo a zoom operation and return to the previous display extents perform 
the following steps:
 

1. Select the graph frame you wish to zoom to previous extents, using the Select Frame  or the Zoom Selection  
 tool. The selected frame will be displayed with resize handles. If the selected graph has previously been zoomed, the 

 Zoom Previous menu command and Zoom Previous  toolbar icon will be enabled. If a previous zoom extent is not 
 available, the menu option and toolbar icon will be grayed.

2. Select the Zoom Previous command from the Zoom menu or click on the Zoom Previous  toolbar icon. The graphs 
 display extents will be reset to the extents prior to the last zoom operation.

 
The Zoom Previous operation can be repeated until no previous display extents are available. For example, if you zoom into the 
graph twice you will be able to select the Zoom Previous command twice. If you zoom in twice, zoom previous once and zoom 
in again you will be able to zoom out twice. The zoom previous operates like a stack of plates. Each time a zoom in operation is 
performed, a previous zoom operation is placed on the stack. If five zoom previous operations are available and you zoom previ-
ous once, four more are still available. Zooming in with those four still on the stack gives you a total of five available, four from the 
original set and one new one. You can zoom in and back out as you wish.
 
Each graph frame has its own Zoom Previous extents stack and is independent of all others.
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6.3. ZOOM ALL
To display the graph in the full extents to the stored data, perform the following steps:
 

1. Select the graph frame you wish to zoom all extents, using the Select Frame   or the Zoom Selection  tool.  
 Selecting the tool and clicking on the graph does this. The selected frame will be displayed with resize handles.

2. Select the Zoom All command from the Zoom menu. The graphs display extents will be reset to the full extents of the 
 tored data. 

6.4. ZOOM IN
The Zoom Selection tool allows you to zoom into a selected area of a graph. Another zoom option is to zoom in by a defined amount. 
The Zoom In command allows you to increase the magnification of a displayed graph by some amount. By default, this amount is 
200% but can be change to any amount you wish. When the zoom operation is selected, the new display extents will be centered 
on the display extents. To zoom in on the center of the display extents, perform the following steps:
 

1. Select the graph frame you wish to zoom in on, using the Select Frame  or the Zoom Selection   tool. The  
 selected frame will be displayed with resize handles. If the selected frame supports zooming, the Zoom In menu command 

 and Zoom In  toolbar icon will be enabled. If the frame does not support zooming, the menu option and toolbar icon 
 will be grayed.

2. Select the Zoom In command from the Zoom menu or click on the Zoom In    toolbar icon. The graph’s display 
 extents will be reset to increase the magnification by the set amount. This amount is 200% by default but can be changed 
 under User Options. 

This zoom operation will place the previous display extents on the Zoom Previous extents stack allowing it to be undone. Refer to 
the Zoom Previous command for a detailed explanation of this feature.
 
This zoom operation always zooms to the center of the displayed graph. You can zoom to a selected point on the graph using the 
Zoom Selection tool. This is done by double-clicking on the point on the graph to zoom into. This has the same effect as drawing 
a zoom selection box half the size of the displayed graph centered around the chosen point. This is a fast way of drilling down 
into the displayed data. This method of zoom also places a display extents entry on the Zoom Previous stack and can be undone. 

6.5. ZOOM OUT
All the previous zoom commands (with the exception of the Zoom Previous command) provide a mechanism to zoom in on a 
graph. Another zoom option, which allows you to zoom out or step back on a graph, is the Zoom Out command. The Zoom Out 
command allows you to decrease the magnification of a displayed graph by some amount. By default, this amount is 200% but 
can be change to any amount you wish. When the Zoom Out operation is selected, the new display extents will be centered on 
the current display extents. To zoom out on the center of the display extents, perform the following steps: 

1. Select the graph frame you wish to zoom out on using the Select Frame  or the Zoom Selection  tool. The 
 selected frame will be displayed with resize handles. If the selected frame supports zooming, the Zoom Out menu 

 command and Zoom Out  toolbar icon will be enabled. If the frame does not support zooming, the menu option and 
 toolbar icon will be grayed.

2. Select the Zoom Out command from the Zoom menu or click on the Zoom Out  toolbar icon. The graph’s display 
 extents will be reset to decrease the magnification by the set amount. This amount is 200% by default but can be changed 
 under User Options.

 
This zoom operation will place the previous display extents on the Zoom Previous extents stack allowing it to be undone. Refer to 
the Zoom Previous command for a detailed explanation of this feature.
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6.6. PANNING
All of the previous zoom operations change the start time and duration of the data to be displayed. This has the effect of zooming 
in or out of an area of the graph. Another method of changing the display extents is called panning. Unlike zooming, panning only 
changes the start time and not the magnification of the displayed graph. Panning is like looking at a picture through a small box. 
The box is smaller than the picture in your report. Sliding the box left and right lets you look at the rest of the picture, a portion at 
a time. The following section shows how you can pan left, right, to the start and to the end of the graph data. 

6.6.1. STEP LEFT

Stepping left, slides the viewing area to display the graph to the left (lower in time) of the currently displayed graph extents. To step 
a graph to the left, perform the following steps:
 

1. Select the graph frame you wish to step left on, using the Select Frame    or the Zoom Selection  tool. The 
 selected frame will be displayed with resize handles. If the selected frame supports panning, the Step Left menu command 

 and Step Left  toolbar icon will be enabled. If the frame does not support panning, the menu option and toolbar icon 
 will be grayed. In addition, this command is disabled if the starting channel data is already displayed.

2. Select the Step Left command from the Zoom menu or click on the Step Left  toolbar icon. The graph’s starting 
 display time will be decreased by 10% of the display duration. This has the effect of sliding the graph window to the left, 
 leaving 90% of the previous extents displayed. This default of 10% can be changed under User Options.

 
This pan operation will place the previous display extents on the Zoom Previous extents stack, allowing it to be undone. Refer to 
the Zoom Previous command for a detailed explanation of this feature.
 
The Step Left command performs the same basic operation as the Pan Left command. The difference being, each has their own 
customizable default shift rates. By default, the step operation shifts the displayed graph by 10%, while the pan operation shifts 
the displayed graph by 90%. 

6.6.2. STEP RIGHT

Stepping right, slides the viewing area to display the graph to the left (higher in time) of the currently displayed graph extents. To 
pan a graph to the right, perform the following steps:
 

1. Select the graph frame you wish to step right on, using the Select Frame    or the Zoom Selection  tool. The 
 selected frame will be displayed with resize handles. If the selected frame supports panning, the Step Right menu 

 command and Step Right  toolbar icon will be enabled. If the frame does not support panning, the menu option and 
toolbar icon will be grayed. In addition, this command is disabled if the ending channel data is already displayed.

2. Select the Step Right command from the Zoom menu or click on the Step Right  toolbar icon. The graph’s starting 
 display time will be increased by 10% of the display duration. This has the effect of sliding the graph window to the right, 
 leaving 90% of the previous extents displayed. This default of 10% can be changed under User Options.

 
This pan operation will place the previous display extents on the Zoom Previous extents stack, allowing it to be undone. Refer to 
the Zoom Previous command for a detailed explanation of this feature.
 
The Step Right command performs the same basic operation as the Pan Right command. The difference being, each has their 
own customizable default shift rates. By default, the step operation shifts the displayed graph by 10%, while the pan operation 
shifts the displayed graph by 90%. 

6.6.3. PAN LEFT

Panning left slides the viewing area to display the graph to the left (lower in time) of the currently displayed graph extents. To pan 
a graph to the left, perform the following steps:

1. Select the graph frame you wish to pan left on using the Select Frame  or the Zoom Selection  tool. The 
 selected frame will be displayed with resize handles. If the selected frame supports panning, the Pan Left menu command

 and Pan Left  toolbar icon will be enabled. If the frame does not support panning, the menu option and toolbar icon 
 will be grayed. In addition, this command is disabled if the starting channel data is already displayed.
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2. Select the Pan Left command from the Zoom menu or click on the Pan Left  toolbar icon. The graph’s starting 
 display time will be decreased by 90% of the display duration. This has the effect of sliding the graph window to the left, 
 leaving 10% of the previous extents displayed. This default of 90% can be changed under User Options.
 

This pan operation will place the previous display extents on the Zoom Previous extents stack allowing it to be undone. Refer to 
the Zoom Previous command for a detailed explanation of this feature.
 
The Pan Left command performs the same basic operation as the Step Left command. The difference being, each has their own 
customizable default shift rates. By default, the step operation shifts the displayed graph by 10%, while the pan operation shifts 
the displayed graph by 90%.

6.6.4. PAN RIGHT

Panning right slides the viewing area to display the graph to the left (higher in time) of the currently displayed graph extents. To 
pan a graph to the right perform the following steps:
 

1. Select the graph frame you wish to pan right on, using the Select Frame  or the Zoom Selection  tool. The 
 selected frame will be displayed with resize handles. If the selected frame supports panning, the Pan Right menu 

 command and Pan Right  toolbar icon will be enabled. If the frame does not support panning, the menu option and 
 toolbar icon will be grayed. In addition, this command is disabled if the ending channel data is already displayed.

2. Select the Pan Right command from the Zoom menu or click on the Pan Right  toolbar icon. The graph’s starting 
 display time will be increased by 90% of the display duration. This has the effect of sliding the graph window to the right, 
 leaving 10% of the previous extents displayed. This default of 90% can be changed under User Options.

 
This pan operation will place the previous display extents on the Zoom Previous extents stack, allowing it to be undone. Refer to 
the Zoom Previous command for a detailed explanation of this feature.
 
The Pan Right command performs the same basic operation as the Step Right command. The difference being, each has their 
own customizable default shift rates. By default, the step operation shifts the displayed graph by 10%, while the pan operation 
shifts the displayed graph by 90%.

6.6.5. PAN TO START

The Pan Left and Pan Right commands slide the displayed graph by an amount determined by the display duration. You can re-
peatedly pan left or right until the start or end of the channel data is reached. You can jump to the beginning of the channel data 
using the Pan To Start command. To pan to the start of the channel data, perform the following steps:
 

1. Select the graph frame you wish to pan to the start of, using the Select Frame  or the Zoom Selection  tool. 
 The selected frame will be displayed with resize handles. If the selected frame supports panning, the Pan To Start menu 

 command and Pan To Start  toolbar icon will be enabled. If the frame does not support panning, the menu option 
 and toolbar icon will be grayed. In addition, this command is disabled if the starting channel data is already displayed.

2. Select the Pan To Start command from the Zoom menu or click on the Pan To Start  toolbar icon. The graph will 
 be displayed, starting with the beginning of the channel data using the same magnification.

 

This pan operation will place the previous display extents on the Zoom Previous extents stack, allowing it to be undone. Refer to 
the Zoom Previous command for a detailed explanation of this feature.
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6.6.6. PAN TO END

As with the Pan To Start command, you can pan all the way to the end of the channel data. To pan to the end of the channel data, 
perform the following steps:
 

1. Select the graph frame you wish to pan to the end of, using the Select Frame  or the Zoom Selection  tool. 
 The selected frame will be displayed with resize handles. If the selected frame supports panning, the Pan To End menu 

 command and Pan To End  toolbar icon will be enabled. If the frame does not support panning, the menu option 
 and toolbar icon will be grayed. In addition, this command is disabled if the ending channel data is already displayed.

2. Select the Pan To End command from the Zoom menu or click on the Pan To End  toolbar icon. The graph will be 
 displayed, such that, it ends with the last sample for the recorded channels.

 
This pan operation will place the previous display extents on the Zoom Previous extents stack, allowing it to be undone. Refer to 
the Zoom Previous command for a detailed explanation of this feature.
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7. PRINTING

7.1. PRINT DIALOG BOX
The following options allow you to specify how the report should be printed:

Printer is the active printer and printer connection. Choose the Setup option to change the printer and printer connection.
 
Print to file prints the report to a file instead of routing it directly to a printer.
 
Properties displays a Printer Setup dialog box specific to the selected printer, so you can select various printer options.
 
Print Range specifies the pages you want to print:
 

 � All prints the entire report.

 � Pages Prints the range of pages you specify in the From and To boxes. If the report contains only one page then this op-
tion is grayed. 

 � Selection Prints the currently selected frame. 
 
Copies specifies the number of copies you want to print for the above page range.

7.2. PRINT PROGRESS DIALOG BOX
The Printing dialog box is shown during the time that DataView® is sending output to the printer. The page number indicates the 
progress of the printing.
 
To abort printing, choose Cancel.

7.3. PRINT PREVIEW TOOLBAR
The print preview toolbar offers you the following options:
 
Print brings up the print dialog box, to start a print job.
 
Next Page previews the next printed page.
 
Prev Page previews the previous printed page.
 
One Page / Two Page preview one or two printed pages at a time.
 
Zoom In takes a closer look at the printed page.
 
Zoom Out takes a larger look at the printed page.
 
Close returns from print preview to the editing window.

7.4. PAGE LAYOUT OPERATIONS
As mentioned previously, DataView® uses a page publishing style of report generation. The report is presented in the view, which 
can contain any number of worksheets. Worksheets can be added and removed as needed.

7.4.1. CHANGING THE PAGE LAYOUT

The layout and size of the pages used in a report are by default, 8.5” x 11” in size with a 0.5” margin around all sides. To change 
the page layout, perform the following steps:

1. Select the Page Setup option from the File menu. The page setup dialog box will be displayed. This dialog box allows 
you to select the paper size and source. The selected printer determines both of which. New views will use the default printer 
and will therefore present that printer’s available options.
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2. Select an alternate printer by clicking on the Printer button. The Page Setup Printer dialog box will be displayed.

3. Select an alternate printer from the drop-down list.

4. You can also change the printer’s specific setup by clicking on the Properties button. The dialog box displayed will be 
 specific to the printer selected in the Page Setup Printer drop-down list. Please refer to your printer documentation for 
 specifics on this printer. Once the printer setup is set, click on the OK button to return to the Page Setup Printer dialog 
 box.

5. Next, click on the OK button to accept the selected printer and return to the Page Setup dialog box.

6. Select the size of the paper from the Size drop-down list.

7. Select the paper source from the Source drop-down list.

8. Select the page orientation (portrait or landscape) by clicking on the corresponding radio button.

9. Specify the left, right, top and bottom margins by clicking on the corresponding field and editing the value. The margins 
 are relative to the corresponding side of the page. For example, the right margin specifies the amount to come in from 
 the right side of the page.

10. Select the OK button to change the page layout for the active report to the specified settings. Select the Cancel button 
 to leave the views page layout as it was.

 
When the report is saved, the page layout, printer and printer setup used to display it are also saved. This helps ensure that the 
WYSIWYG aspect of a report is maintained, even if the default Windows® printer is changed after the report is created. 

7.5. PRINTING OPERATIONS
Once the report has been created, it can be printed to produce a hardcopy report. You can print views to any of the installed Windows® 
printers and page sizes. Different printers and page sizes are selected through the Page Setup and Print Setup dialog boxes.

7.5.1. PRINT PREVIEW

Although DataView® uses a WYSIWYG display of frames, it is not always exactly as it would be when printed. To get a closer view 
of what the printed pages will look like, you can preview them. To preview the printed pages, perform the following steps:
 

1. Select the Print Preview command from the File menu or click on the Print Preview  toolbar icon. DataView® will 
 enter the print preview mode. This screen displays the first worksheet in the report in its entirety. You can quickly see how 
 the frames will appear on the printed worksheet.

2. If the report contains more than one worksheet, the Next Page button will be enabled. Clicking on this button will display 
 the worksheet following the one currently displayed. If this is the only worksheet or last worksheet in the report, the Next 
 Page button will be grayed and disabled.

3. If the displayed page is not the first, then the Prev Page button will be enabled. Clicking on this button will display the 
 page preceding the one currently displayed. If this is the only page or the first page in the report, then the Prev Page 
 button will be grayed and disabled.

4. If the report contains more than one page and the pages are displayed at the lowest magnification (full-page display), the 
 Two-Page button will be enabled. Clicking on this button will display two pages, side by side, and the Two-Page button 
 will be renamed to One-Page. Clicking on this button again will return DataView® to displaying a single page at a time.

5. When the entire page is displayed (lowest magnification), the mouse pointer becomes a magnifying glass. Clicking the 
 left mouse button while the pointer is over the page, will increase the magnification of the selected area. Clicking the left 
 mouse button again will further increase the magnification. This time, the mouse pointer will become a selection arrow, 
 indicating that you are at the maximum magnification. Clicking the left mouse button over the page will reset the
 magnification, such that the entire page is displayed (reset to lowest magnification). Also, notice that while you are viewing 
 at increased magnification, the Two-Page button is disabled. You can only view two pages while at the lowest 
 magnification. In addition, if you are viewing two pages prior to increasing the magnification, the selected page will be 
 displayed at the higher magnification.

6. As with the magnifying glass mouse pointer, clicking the Zoom In button will increase the display magnification. Clicking 
 on the Zoom In button a second time will display the page at the maximum magnification. When viewing at maximum 
 magnification, the Zoom In button is disabled.
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7. When viewing a page at an increased magnification, the Zoom Out button is enabled. Clicking on the Zoom Out button 
 will decrease the display magnification. When viewing the page at the lowest magnification, the Zoom Out button is 
 disabled.

8. Clicking on the Print button will close the preview window and automatically bring up the print dialog box, at which point 
 you can print all or selected pages of the report. Refer to the following section on printing the report.

9. Clicking on the Close button will close the preview window and return you to normal operation of DataView®.
 
When selecting print preview, the active report enters the preview mode. Any other open views can be selected and operated while 
this report is still in preview mode. Preview mode is a special display mode that emulates the printed page. While in preview mode, 
the pages can only be viewed but not modified.
 

7.5.2. PRINTING THE VIEW

Once the data has been viewed and analyzed, a hard copy report of the report may be desired. All views displayed by DataView® 
can be printed as well. To print the active report, perform the following steps:
 

1. Select the Print command from the File menu, or click on the Print  toolbar icon. The Print dialog box will be 
 displayed. This dialog box allows you to select an alternate printer and change its properties. If you change the printer 
 here and continue with the print operation, you will not be able to preview the pages before they are printed. The printed 
 pages may not appear as they did while viewing because they were printed using a different driver. For this reason, it is 
 suggested that you first change the printer using the Print Setup command, preview the pages with the new printer, then 
 print the pages. This will help ensure that the printed pages are what you wanted.

2. If the report to be printed has more than one page, you will be able to specify the Print range. You can select all pages or 
 a range of pages. If the report only has one page, then All is the only Print range selection available.

3. If the selected printer supports making copies, you will be able to specify the number of copies of the specified pages to 
 print. If the printer does not support making copies, then the Number of copies option will be grayed.

4. Once all the desired selections are made, click on the OK button to start printing. If you decide not to print the report, click 
 on the Cancel button and the dialog box will close without printing.
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